Authoring for Dolby Atmos® Cinema Sound Manual

Issue 3
Software v1.4
Table of Contents

Chapter 1 Introduction to Dolby Atmos Authoring Tools ................................................. 1
  1.1 Dolby Atmos Overview ........................................................................................................ 1
  1.2 Dolby Atmos System Overview ........................................................................................... 2
  1.3 Dolby Atmos Metadata Flow with Different Setups ............................................................. 2
  1.4 Dolby Atmos Monitor Application ...................................................................................... 4
  1.5 Dolby Atmos Panner Plug-in ............................................................................................... 4
  1.6 Optional Authoring Tools ..................................................................................................... 5
  1.7 About This Manual .............................................................................................................. 6
    1.7.1 Dolby Atmos Authoring Manuals ............................................................................... 6
  1.8 Terminology ......................................................................................................................... 6
  1.9 Questions or Feedback for Authoring ................................................................................. 7

Chapter 2 Installing the Dolby Atmos Authoring Tools ................................................. 9
  2.1 Installing the Dolby Atmos Tools on a Pro Tools System ................................................... 9
    2.1.1 Authorizing the Dolby Atmos Plug-ins ..................................................................... 10
  2.2 Installing the Monitor Application on Additional Devices ................................................... 11
  2.3 Getting Started (Overview) ................................................................................................ 11

Chapter 3 Setting Up a Pro Tools Session ................................................................ 13
  3.1 Dolby Atmos Format in Pro Tools ..................................................................................... 13
    3.1.1 Dolby Atmos Format and Multichannel Mixing ........................................................ 14
    3.1.2 Considerations When Routing Pro Tools Physical Outputs to RMU MADI Inputs .. 15
  3.2 Pro Tools Session Requirements ...................................................................................... 16
  3.3 Authoring in a Pro Tools Session ...................................................................................... 17
    3.3.1 Working with the Bed ............................................................................................... 17
    3.3.2 Working with Objects ............................................................................................... 18
  3.4 Creating a Pro Tools Session for Dolby Atmos ................................................................. 18
    3.4.1 Creating a New Pro Tools Session .......................................................................... 18
    3.4.2 Reconfiguring an Existing Session .......................................................................... 19
    3.4.3 Working with 23.98 fps ............................................................................................. 20
  3.5 Configuring I/O Setup ........................................................................................................ 21
    3.5.1 Configuring Output ................................................................................................... 22
    3.5.2 Configuring Input ................................................................................................... 23
    3.5.3 Bus Mapping ............................................................................................................ 24
Chapter 4 Using the Dolby Atmos Monitor Application

4.1 Before Using the Monitor Application ................................................................. 30
4.2 Launching the Monitor Application ................................................................. 30
4.3 Waiting for Room Configuration Message ..................................................... 31
4.4 Enabling Communication with the RMU ......................................................... 31
  4.4.1 Enabling Communication from the Pro Tools Computer (Required) .... 32
  4.4.2 Enabling Communication from Other Devices (Optional) ............... 33
  4.4.3 Verifying Communication with the RMU .............................................. 34
4.5 Loading a .dac Room Configuration File (Required) .................................. 34
  4.5.1 Verifying the Room Configuration File ................................................. 36
4.6 Rendering ........................................................................................................ 37
  4.6.1 Rendering to the Dolby Atmos Format .................................................. 37
  4.6.2 Re-rendering to a Surround Format ..................................................... 38
4.7 Monitor Application Operation Modes ......................................................... 40
  4.7.1 Live Mode Monitoring of Pro Tools ....................................................... 40
  4.7.2 Recording a Dolby Atmos Print Master ............................................... 41
  4.7.3 Punching In and Out of a Print-Master Recording ............................... 42
  4.7.4 Playing Back a Print Master ................................................................. 43
4.8 Monitoring with the Dolby Atmos Monitor Application ............................. 44
  4.8.1 Considerations for Hearing Dolby Atmos Audio ............................... 45
  4.8.2 Selecting a Monitor Application View .................................................. 46
  4.8.3 Monitoring Objects ................................................................................ 48
  4.8.4 Monitoring RMU Outputs ...................................................................... 53
  4.8.5 Monitoring the Room Configuration and Speakers .......................... 57
  4.8.6 Dimming RMU Audio Output ............................................................... 58
  4.8.7 Changing the Gain of RMU Audio Output ........................................ 59
  4.8.8 Muting RMU Audio Output ................................................................... 59
  4.8.9 Monitoring Object Audio Only (Objects Only Mode) ...................... 59
  4.8.10 Clearing Clips in the RMU Output Meters ........................................ 60
4.9 Monitor Application Keyboard Shortcuts Reference ..................................... 61
4.10 Monitor Application Controls and Displays Overview .................................. 61
  4.10.1 Monitor Application Window Header ............................................... 62
  4.10.2 Signal Generator .................................................................................. 66

Chapter 5 Using the Panner Plug-in to Position Objects

5.1 General Use of the Panner in Pro Tools ......................................................... 71
5.2 Special Considerations when Using the Panner ........................................... 71
5.3 Panner Plug-in Window Controls and Displays ............................................ 71
  5.3.1 Panner Virtual Room ........................................................................... 72
  5.3.2 Object Number Box ............................................................................ 73
  5.3.3 Operation Mode Buttons and Zones Selector ..................................... 74
  5.3.4 X/Y/Z Sliders and Position Displays ................................................... 75
  5.3.5 Object Size Slider and Level Display .................................................. 76
  5.3.6 Configuration Options Button ............................................................. 79
  5.3.7 Linking Selector (Stereo Plug-in Only) .................................................. 80
5.4 Inserting a Panner Plug-in in Pro Tools ................................................................. 80
  5.4.1 Manually Assigning an Object Number .......................................................... 81
  5.4.2 Inserting Multiple Plug-ins and Automatically Assigning Object Numbers .......... 84
5.5 Controlling the Panner ......................................................................................... 85
  5.5.1 Using a Joystick ............................................................................................... 86
  5.5.2 Using a Control Surface or Mixing Console ....................................................... 88
  5.5.3 Positioning an Object Using a Mouse ............................................................... 91
  5.5.4 Positioning an Object Using a Keyboard ......................................................... 91
5.6 Operation Modes .................................................................................................. 91
  5.6.1 Bypass (Master Bypass) Mode ......................................................................... 91
  5.6.2 Default Mode .................................................................................................. 92
  5.6.3 Using Elevation Mode ..................................................................................... 92
  5.6.4 Using Elevation Snap Modes ......................................................................... 93
  5.6.5 Recording Metadata from the RMU ................................................................. 95
  5.6.6 Using Speaker Snap Mode ............................................................................. 99
  5.6.7 Zones ............................................................................................................. 99
5.7 Linking Stereo Panner Plug-in Controls ............................................................... 100
  5.7.1 Stereo Panner Linking Options ...................................................................... 101
5.8 Automating Panner Controls ................................................................................ 102
5.9 Resizing the Panner Plug-in Window ................................................................. 103

Chapter 6 Workflows ............................................................................................... 105
  6.1 Using Traditional Dolby 7.1 (or 5.1) Mix Audio Files to Create a Dolby Atmos Mix .... 105
  6.2 Using Traditional Dolby 7.1 (or 5.1) Mix Audio Channels and Console Automation to Create a Dolby Atmos Mix ................................................................. 112

Index ....................................................................................................................... 121
List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1-1</td>
<td>Simplified Dolby Atmos Block Diagram</td>
<td>1</td>
</tr>
<tr>
<td>Figure 1-2</td>
<td>Basic Dolby Atmos System Block Diagram</td>
<td>2</td>
</tr>
<tr>
<td>Figure 1-3</td>
<td>Basic Setup with Pro Tools Machine Sending Metadata to Dolby RMU</td>
<td>2</td>
</tr>
<tr>
<td>Figure 1-4</td>
<td>Page Table Control Surface Added to Basic Setup</td>
<td>3</td>
</tr>
<tr>
<td>Figure 1-5</td>
<td>System 5 and System 5 Panner Application or Other Client Application Added to Basic Setup</td>
<td>3</td>
</tr>
<tr>
<td>Figure 1-6</td>
<td>Mixing Console with Automation Engine Added to Basic Setup</td>
<td>3</td>
</tr>
<tr>
<td>Figure 1-7</td>
<td>Dolby Atmos Monitor Application</td>
<td>4</td>
</tr>
<tr>
<td>Figure 1-8</td>
<td>Panner Plug-in, Mono Version</td>
<td>5</td>
</tr>
<tr>
<td>Figure 3-1</td>
<td>Basic Dolby Atmos Block Diagram</td>
<td>14</td>
</tr>
<tr>
<td>Figure 3-2</td>
<td>Audio Routing Diagram</td>
<td>16</td>
</tr>
<tr>
<td>Figure 3-3</td>
<td>Session Setup Window Configured for Dolby Atmos</td>
<td>19</td>
</tr>
<tr>
<td>Figure 3-4</td>
<td>I/O Setup Output, Configured for Dolby Atmos</td>
<td>22</td>
</tr>
<tr>
<td>Figure 3-5</td>
<td>I/O Setup Bus Mapping, Configured for Dolby Atmos</td>
<td>24</td>
</tr>
<tr>
<td>Figure 3-6</td>
<td>Dolby Atmos Tracks and Track Main Outputs Set to Dolby Atmos Paths</td>
<td>25</td>
</tr>
<tr>
<td>Figure 4-1</td>
<td>Dolby Atmos Monitor Application</td>
<td>29</td>
</tr>
<tr>
<td>Figure 4-2</td>
<td>Dolby Atmos Monitor Application Icon</td>
<td>30</td>
</tr>
<tr>
<td>Figure 4-3</td>
<td>Waiting for Room Configuration Message in the Default Monitor Application Window</td>
<td>31</td>
</tr>
<tr>
<td>Figure 4-6</td>
<td>Default Monitor Application Window (When Not Communicating from Pro Tools)</td>
<td>32</td>
</tr>
<tr>
<td>Figure 4-7</td>
<td>Dolby Atmos Preferences</td>
<td>33</td>
</tr>
<tr>
<td>Figure 4-8</td>
<td>Successful Connection Between Monitor and RMU Host Name</td>
<td>34</td>
</tr>
<tr>
<td>Figure 4-9</td>
<td>Dolby RMU Web Client, Default Window</td>
<td>35</td>
</tr>
<tr>
<td>Figure 4-10</td>
<td>Setting Management Section of the Maintenance Screen</td>
<td>35</td>
</tr>
<tr>
<td>Figure 4-11</td>
<td>Successful Room Configuration in the Monitor Application Main Window</td>
<td>36</td>
</tr>
<tr>
<td>Figure 4-12</td>
<td>All View in the Monitor Application</td>
<td>46</td>
</tr>
<tr>
<td>Figure 4-13</td>
<td>Meters View in the Monitor Application</td>
<td>47</td>
</tr>
<tr>
<td>Figure 4-14</td>
<td>Objects View Only in the Monitor Application</td>
<td>48</td>
</tr>
<tr>
<td>Figure 4-15</td>
<td>Object Stream Circles and Stream Information</td>
<td>49</td>
</tr>
<tr>
<td>Figure 4-16</td>
<td>Object Stream Circles and Stream Information</td>
<td>49</td>
</tr>
<tr>
<td>Figure 4-17</td>
<td>Objects View Outline and Front Screen</td>
<td>50</td>
</tr>
<tr>
<td>Figure 4-18</td>
<td>Rotated Display of Objects View</td>
<td>51</td>
</tr>
<tr>
<td>Figure 4-19</td>
<td>Side Display of Objects View</td>
<td>51</td>
</tr>
<tr>
<td>Figure 4-20</td>
<td>Overhead Display of Objects View</td>
<td>52</td>
</tr>
<tr>
<td>Figure 4-21</td>
<td>Objects View, Yellow and Transparent Fills Shown</td>
<td>52</td>
</tr>
<tr>
<td>Figure 4-22</td>
<td>Objects View, Blue Object</td>
<td>53</td>
</tr>
<tr>
<td>Figure 4-23</td>
<td>Rendering to Dolby Atmos Format, Ten Meters Shown</td>
<td>54</td>
</tr>
<tr>
<td>Figure 4-24</td>
<td>Rendering to 7.1 Channels, Eight Meters Shown</td>
<td>55</td>
</tr>
<tr>
<td>Figure 4-25</td>
<td>Rendering to 5.1 Channels, Six Meters Shown</td>
<td>56</td>
</tr>
<tr>
<td>Figure 4-26</td>
<td>Room Configuration in the Monitor Application Main Window</td>
<td>57</td>
</tr>
<tr>
<td>Figure 4-27</td>
<td>Room Configuration Indicators</td>
<td>58</td>
</tr>
<tr>
<td>Figure 4-28</td>
<td>Successful Connection Between Monitor and RMU Host Name</td>
<td>58</td>
</tr>
<tr>
<td>Figure 4-29</td>
<td>Objects Only Mode</td>
<td>60</td>
</tr>
<tr>
<td>Figure 4-30</td>
<td>Monitor Application Window Header</td>
<td>62</td>
</tr>
<tr>
<td>Figure 4-31</td>
<td>Successful Connection Between Monitor and RMU</td>
<td>62</td>
</tr>
<tr>
<td>Figure 4-32</td>
<td>Generating Pink Noise to a Speaker (Speaker Icon with a Box)</td>
<td>66</td>
</tr>
<tr>
<td>Figure 4-33</td>
<td>Generating Pink Noise to a Speaker (Speaker Icon with a Box)</td>
<td>67</td>
</tr>
<tr>
<td>Figure 4-34</td>
<td>Generating Pink Noise to the Rss Speaker Array</td>
<td>68</td>
</tr>
<tr>
<td>Figure 5-1</td>
<td>Dolby Atmos Panner Plug-in, Mono Version</td>
<td>70</td>
</tr>
<tr>
<td>Figure 5-2</td>
<td>Panner Virtual Room Elements</td>
<td>72</td>
</tr>
<tr>
<td>Figure 5-3</td>
<td>Default Dolby Atmos Panner Plug-in with No Number Assignment</td>
<td>74</td>
</tr>
</tbody>
</table>
Figure 5-4 Increasing Object Size from the Room Center ................................................................. 77
Figure 5-5 Increasing Object Size from a Side Wall ......................................................................... 78
Figure 5-6 Configuration Options Button .......................................................................................... 79
Figure 5-7 Dolby Atmos Panner Plug-in for a Stereo Track ................................................................ 80
Figure 5-8 Configuration Options Button in a Panner Plug-in ............................................................ 82
Figure 5-9 Object ID Selector in a Panner Plug-in .............................................................................. 83
Figure 5-10 Renderer Connection Status in the Object ID Section ...................................................... 84
Figure 5-11 Selecting the Joystick Device .......................................................................................... 88
Figure 5-12 Configuration Options Button in a Panner Plug-in .......................................................... 97
Figure 5-13 Recorder Mode Button in a Panner Plug-in .................................................................... 98
Figure 5-14 Linking Selector in a Stereo Panner Plug-in, Set to Mirrored ........................................... 101
Figure 6-1 Basic Dolby Atmos System Block Diagram ....................................................................... 105
Figure 6-2 I/O Setup Output, Configured for Dolby Atmos ............................................................... 106
Figure 6-3 VCA Master Tracks Assigned to Each Effects and Foley Premix .................................... 107
Figure 6-4 Mix/Edit Groups in Pro Tools Groups Window, Active Groups in Gray ............................ 108
Figure 6-5 Pro Tools Mix Window, Showing VCA Master Tracks Only ............................................. 109
Figure 6-6 Pro Tools Edit Window, Showing Dialogue Reverb Returns with VCA Master Tracks ....... 111
Figure 6-7 7.1 Mix Stage Mirrored by Dolby Atmos Mix Stage ......................................................... 112
Figure 6-8 Dolby Atmos Mix Stage Block Diagram ........................................................................... 113
## List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1-1</td>
<td>Abbreviations</td>
<td>6</td>
</tr>
<tr>
<td>Table 1-2</td>
<td>Dolby Atmos Channel Abbreviations</td>
<td>7</td>
</tr>
<tr>
<td>Table 3-1</td>
<td>Dolby Atmos Specification for Pro Tools</td>
<td>14</td>
</tr>
<tr>
<td>Table 3-2</td>
<td>Rendering and Mastering Unit MADI Inputs in a Dolby Atmos System</td>
<td>15</td>
</tr>
<tr>
<td>Table 3-3</td>
<td>I/O Setup Specification for Dolby Atmos</td>
<td>21</td>
</tr>
<tr>
<td>Table 4-1</td>
<td>Monitor Application Shortcuts Reference</td>
<td>61</td>
</tr>
<tr>
<td>Table 5-1</td>
<td>JLCooper MCS-Panner Joystick Switch and Knob Reference for Dolby Atmos Panner</td>
<td>86</td>
</tr>
<tr>
<td>Table 5-2</td>
<td>Panner Support by Control Surfaces and Mixing Consoles</td>
<td>89</td>
</tr>
</tbody>
</table>
Introduction to Dolby Atmos Authoring Tools

All Dolby Atmos® systems include the following primary authoring tools:

- Dolby Atmos Monitor application
- Dolby Atmos Panner plug-in

Use these tools to author sound for digital cinema and to create a print master. You can also use the Monitor application to play back a print master.

The Dolby® Rendering and Mastering Unit (RMU), the core intelligent component of the Dolby Atmos audio authoring system, includes preinstalled software for various tasks in a Dolby Atmos authoring workflow. You use the Dolby Atmos Designer application to calibrate the mix stage and create a room configuration, and you use the Dolby RMU web client in tandem with the Monitor application to modify Renderer software operations (for example, to load a room configuration, listen to a Dolby Atmos mix, record a print master, or play back a print master). See the manual for your Dolby Rendering and Mastering Unit for detailed information.

For information on additional authoring tools, see Optional Authoring Tools.

1.1 Dolby Atmos Overview

A Dolby Atmos mix consists of three primary elements:

- Bed audio (or bed material): Channel-based premixes or stems (including their multichannel panning)
- Object audio (or objects): Mono or stereo soundtrack content that have dedicated panning (via Dolby Atmos metadata)
- Dolby Atmos metadata: Panner automation for objects, plus additional metadata

![Figure 1-1  Simplified Dolby Atmos Block Diagram](image-url)
1.2 Dolby Atmos System Overview

In a basic Dolby Atmos system, one or more Avid® Pro Tools® machines define the audio and metadata.

- Pro Tools multichannel tracks and signal routing define bed and object audio. High-Definition Multichannel Audio Digital Interface (HD MADI) format interfaces receive audio from Pro Tools and send it to the Dolby RMU.
- Panner plug-ins on audio tracks in Pro Tools that contain object audio, along with their automation playlists, define Dolby Atmos metadata. One or more Pro Tools machines route metadata directly to the Dolby RMU via Ethernet.

![Figure 1-2 Basic Dolby Atmos System Block Diagram](image)

1.3 Dolby Atmos Metadata Flow with Different Setups

The flow of metadata in a Dolby Atmos system is dependent on the type of system setup.

There are four primary Dolby Atmos system setups for sending metadata (and audio) to the RMU:

- One or more Pro Tools machines sending metadata to Dolby RMU

![Figure 1-3 Basic Setup with Pro Tools Machine Sending Metadata to Dolby RMU](image)
• Page table control surface (such as an Avid D-Command® or Avid D-Control™) added to a system with one or more Pro Tools machines sending metadata to Dolby RMU

![Figure 1-4 Page Table Control Surface Added to Basic Setup](image1)

• Mixing console (such as an Avid System 5 or AMS Neve DFC Gemini) with supporting software, or other client application sending metadata to the Dolby RMU (and onward to Pro Tools, which in turn sends all metadata back to the RMU)

![Figure 1-5 System 5 and System 5 Panner Application or Other Client Application Added to Basic Setup](image2)

• Console as automation master; mixing console (such as an AMS Neve DFC Gemini), with automation engine sending metadata to the Dolby RMU, and Pro Tools recording the metadata (via Recorder mode in Panner plug-ins)

![Figure 1-6 Mixing Console with Automation Engine Added to Basic Setup](image3)
1.4 Dolby Atmos Monitor Application

Use the Dolby Atmos Monitor application for audio and visual monitoring of the Dolby RMU as it renders audio and Dolby Atmos metadata.

The Monitor application provides controls for the RMU renderer. Use it to:

- Change the rendering mode of the RMU between Dolby Atmos and traditional 7.1 or 5.1 channel-based mixes
- Record a print master
- Play back a print master
- Connect a machine to the RMU and its renderer

The Monitor application includes a bar meter, object signal present indicators, and an object positional display. It also provides the active speaker configuration, which contains signal present indicators and speaker mutes. Controls (such as mute and attenuation) are provided for B-chain control.

1.5 Dolby Atmos Panner Plug-in

Use the Dolby Panner plug-in to position audio objects (such as effects) in a three-dimensional audio field. Panner plug-ins are inserted on each Pro Tools mono or stereo
track designated for an object. Plug-in panner position and other Dolby Atmos metadata can be written to Pro Tools automation playlists. Pro Tools sends the automation metadata to the RMU (via Ethernet), along with audio from Pro Tools outputs to the RMU (via MADI), for rendering during monitoring or print-master recording.

![Figure 1-8  Panner Plug-in, Mono Version](image)

### 1.6 Optional Authoring Tools

Depending on your Dolby Atmos system and workflow, you may also use optional authoring tools:

- **Local Renderer Plug-in Suite:** The Dolby Atmos Local Renderer plug-in suite (or local renderer) lets you create, edit, and monitor Dolby Atmos material in a mix room or edit suite that is not configured with a Dolby Rendering and Mastering Unit (RMU). See the manual for your Dolby Rendering and Mastering Unit.

- **Avid System 5 console:** For systems with Avid System 5 mixing consoles, you can do either of the following:
  - Use the System 5 Panner EUCON application from Dolby. This application provides support for mapping x- and y-axis positioning of a Dolby Atmos object to joysticks on an Avid System 5, as well as mapping the panner controls of each Dolby Atmos object to a dedicated channel strip (or panner strip). See the System 5 Panner Application for Dolby Atmos Manual.
  - Use the System 5 v6.0 software update from Avid. This update has direct RMU communication enabled. See your console documentation.

- **AMS Neve DFC console:** See your console documentation.
• Harrison MPC or Trion console running the IKIS automation engine: See your console documentation.

## 1.7 About This Manual

This manual provides information for getting started with Dolby Atmos authoring tools in a Dolby Atmos system:

- Introduction to Dolby Authoring Tools
- Installing the Dolby Atmos Authoring Tools
- Setting Up Pro Tools Sessions
- Using the Dolby Atmos Monitor
- Workflows

This manual is for engineers, sound designers, and others who use Dolby Atmos tools for authoring sound for digital cinema and to create a print master.

### 1.7.1 Dolby Atmos Authoring Manuals

Use the primary Dolby Atmos authoring manuals in the following order:

- What’s New in Dolby Atmos Mixing Tools: Refer to this manual for update installation instructions, new features and improvements, and known issues for Dolby Atmos mixing tools.
- Dolby Rendering and Mastering Unit Manual for Cinema User Manual: Refer to this manual to install and connect your Dolby RMU hardware interface in a Dolby Atmos authoring system for cinema, and then set up and use RMU software preinstalled on the Dolby RMU.
- Authoring for Dolby Atmos Cinema Sound Manual: Refer to this manual to create and work with Dolby Atmos material by using Dolby Atmos tools and other authoring software.

## 1.8 Terminology

The following table lists abbreviations used throughout this document.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LTC</td>
<td>Linear timecode</td>
</tr>
<tr>
<td>MADI</td>
<td>Multichannel Audio Digital Interface</td>
</tr>
<tr>
<td>M&amp;E</td>
<td>Music and Effects</td>
</tr>
<tr>
<td>RMU</td>
<td>Dolby Rendering and Mastering Unit</td>
</tr>
<tr>
<td>SDDS®</td>
<td>Sony® Dynamic Digital Sound</td>
</tr>
<tr>
<td>UI</td>
<td>User interface</td>
</tr>
</tbody>
</table>
The following table lists channel notations used in this document.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>Left</td>
</tr>
<tr>
<td>R</td>
<td>Right</td>
</tr>
<tr>
<td>C</td>
<td>Center</td>
</tr>
<tr>
<td>S</td>
<td>Surround</td>
</tr>
<tr>
<td>Ls</td>
<td>Left Surround</td>
</tr>
<tr>
<td>Rs</td>
<td>Right Surround</td>
</tr>
<tr>
<td>Lsr</td>
<td>Left Surround Rear</td>
</tr>
<tr>
<td>Rsr</td>
<td>Right Surround Rear</td>
</tr>
<tr>
<td>Lss</td>
<td>Left Side Surround</td>
</tr>
<tr>
<td>Rss</td>
<td>Rear Side Surround</td>
</tr>
<tr>
<td>Lts</td>
<td>Left Top Surround</td>
</tr>
<tr>
<td>Rts</td>
<td>Right Top Surround</td>
</tr>
<tr>
<td>LFE</td>
<td>Low-Frequency Effects</td>
</tr>
</tbody>
</table>

1.9 Questions or Feedback for Authoring

If you have questions or comments about this document, please contact technical publications (documentation@dolby.com).

If you have technical questions about this product, please contact CinemaSupport@dolby.com.
Chapter 2

Installing the Dolby Atmos Authoring Tools

The Dolby Atmos® authoring tools installer includes:

• Primary authoring tools:
  • Dolby Atmos Monitor application.
  • Dolby Atmos Panner plug-in.

• Optional authoring tools:
  • System 5 Panner application. See the System 5 Panner Application for Dolby Atmos Manual.

2.1 Installing the Dolby Atmos Tools on a Pro Tools System

You must install the authoring tools on an Apple® Mac® OS® X® computer running an Avid® Pro Tools® |HDX or |HD system qualified for Dolby Atmos.

Note: The Monitor application located on the Pro Tools computer system is required for establishing communication between Panner plug-ins in Pro Tools and the RMU. See Communicating from the Pro Tools System. Following installation, the Monitor application can be installed on additional devices for dedicated (or secondary) monitoring.

The Dolby Atmos authoring tools installer includes a 64-bit version of the Panner plug-in and a 32-bit version. The 64-bit Panner is required for Dolby Atmos systems with Avid Pro Tools 11.2.1 running on Mac OS X 10.9.4 (Mavericks). The 32-bit version of the Panner is included for Pro Tools 10.3.9 systems running on Mac OS X 10.8.5 (Mountain Lion). For full requirements, refer to your Dolby Content Services representative.

To install the Dolby Atmos authoring tools:

1. Quit Pro Tools if it is running.
2. If updating, quit the Dolby Atmos Monitor application if it is running.
3. Double-click the DolbyAtmosTools installer package.
4. Follow the onscreen instructions.

When installation is completed, the tools and their supporting files are written to disk.

<table>
<thead>
<tr>
<th>File (and File Name)</th>
<th>Location After Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dolby Atmos Monitor (Dolby Atmos Monitor.app)</td>
<td>/Applications/Dolby folder</td>
</tr>
</tbody>
</table>
Installing the Dolby Atmos Authoring Tools

<table>
<thead>
<tr>
<th>File (and File Name)</th>
<th>Location After Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dolby Atmos Panner plug-in (Dolby Atmos Panner.aaxplugin)</td>
<td>The Pro Tools Plug-ins folder for AAX format plug-ins</td>
</tr>
<tr>
<td>System 5 Panner application (system5panner)</td>
<td>/Applications/Dolby folder</td>
</tr>
</tbody>
</table>

After installation has completed, verify that the Dolby Atmos Panner plug-in license is on a USB iLok attached to the Pro Tools system.

The licenses authorize your system to use the Dolby Atmos plug-ins. See Authorizing the Dolby Atmos Plug-ins.

Note:
The System 5 Panner application can coexist on a computer with a Pro Tools session open, but EUCON™ mode must be disabled in Pro Tools (in Setup > Peripherals > Ethernet Controllers). For example, use a Pro Tools computer dedicated to video, which does not require System 5 control of Pro Tools. For more information, see the System 5 Panner Application for Dolby Atmos Manual.

2.1.1 Authorizing the Dolby Atmos Plug-ins

Dolby Atmos plug-ins use PACE iLok antipiracy software. The Dolby Atmos Panner plug-in license stored on a USB iLok key (not supplied) authorizes your system to use the Panner plug-in.

Insert the iLok into an available USB port before opening Pro Tools. The iLok key must remain in the USB port while Pro Tools is in use.

The iLok License Manager, downloadable from the iLok website (www.ilok.com), enables you to manage the licenses for all of your iLok-protected applications in one place.

To register your license:
1. Make sure you have a physical iLok USB smart key (not supplied) and that it is inserted on a USB port on your computer.
2. If you do not have an existing account, go to www.ilok.com and follow the directions to sign up for a free account.
3. If you do not have iLok License Manager installed on one of your computers, go to www.ilok.com and follow the directions to download it.
4. Launch the iLok License Manager.
5. In the iLok License Manager window, sign in to your account.
6. Click (highlight) your account name in the navigation bar.
7. View the available licenses for your account and drag the licenses to your iLok.

**Note:** If you have been given license codes for your Dolby® applications, use the iLok License Manager to load the licenses to your new or existing iLok key.

---

### iLok Zero Downtime Coverage

The iLok Zero DownTime program enables iLok owners to immediately replace licenses in case an iLok is broken, lost, or stolen. Visit [www.ilok.com](http://www.ilok.com) for program details and restrictions.

---

### 2.2 Installing the Monitor Application on Additional Devices

You can install one or more dedicated Monitor applications on devices other than the Pro Tools computer for Dolby Atmos. In this scenario, each secondary Monitor application enables communication with the Dolby RMU for RMU monitoring only.

For information on enabling secondary Monitor applications, see [Communicating from Other Devices](#).  

**Note:** Secondary Monitor applications do not establish communication between the Panner plug-ins in Pro Tools and the RMU. Communication between the Panner plug-ins in Pro Tools and the RMU must first be established on the Pro Tools computer. See [Communicating from the Pro Tools System](#).

To install the Monitor application on a different Mac OS X computer:

1. If the destination computer does not have Pro Tools installed on it, create an /Applications/Dolby folder.
2. On the destination computer, double-click the DolbyAtmosTools installer package.
3. Follow the onscreen instructions.

### 2.3 Getting Started (Overview)

Before you begin using Dolby Atmos authoring tools, verify the following:

- The RMU hardware interface is installed and connected in a Dolby Atmos authoring system, as described in the manual for your Dolby Rendering and Mastering Unit.
- Dolby RMU software has been set up, as described in the manual for your Dolby Rendering and Mastering Unit. For cinema, this includes calibrating the mix stage, creating an RMU room configuration using Dolby Atmos Designer software, and then loading the room configuration using the Dolby RMU web client.
Here is an overview of how to use Dolby Atmos authoring tools in a basic authoring workflow:

1. Power on the Pro Tools system and individual Pro Tools machines, as described in Pro Tools documentation.
2. Power on the Dolby RMU.
3. Launch the Dolby Atmos Monitor application on the primary Pro Tools machine, and enable communication with the RMU.
4. Set up Pro Tools sessions and insert Panner plug-ins for Dolby Atmos, as needed.
5. If using an Avid System 5 mixing console to control Dolby Atmos metadata, set up the System 5:
   a. Launch the System 5 eMix software and appropriate routing.
   b. Launch the System 5 Panner on the machine it is installed on. For more information, see the *System 5 Panner Application for Dolby Atmos Manual*.
   c. Create panner strips on the console. For more information, see the *System 5 Panner Application for Dolby Atmos Manual*.
6. If using an AMS Neve DFC console to author in the Dolby Atmos format, refer to your console documentation.
7. If using a Harrison MPC or Trion console running the IKIS automation engine to author in the Dolby Atmos format, refer to your console documentation.
9. Play back the Dolby Atmos session to audition audio from the RMU outputs. If audio is inaudible, refer to *Hearing Dolby Atmos Audio*.
10. When the Dolby Atmos mix is completed, create a Dolby Atmos print master. See *Recording a Dolby Atmos Print Master*. 

*Installing the Dolby Atmos Authoring Tools*
Setting Up a Pro Tools Session

Use Pro Tools® digital audio workstation software for primary authoring in the Dolby Atmos® format.

Dolby Atmos authoring tools are supported on an Apple® Mac® OS X® computer running an Avid® Pro Tools® HDX or | HD system qualified for Dolby Atmos. For more information about Dolby Atmos system requirements, refer to your Dolby® Content Services representative.

**Note:** You can use a mixing console with an automation engine (such as the AMS Neve DFC) instead of Pro Tools, or in conjunction with Pro Tools, to author in the Dolby Atmos format. Refer to your control surface or console documentation.

### 3.1 Dolby Atmos Format in Pro Tools

Before creating a Pro Tools session for Dolby Atmos, you should review the Dolby Atmos format and how it relates to Pro Tools multichannel mixing.
3.1.1 Dolby Atmos Format and Multichannel Mixing

The Dolby Atmos format is built from audio bed material and objects in Pro Tools session tracks (per the Dolby Atmos specification for Pro Tools), plus metadata, which is defined by Panner plug-ins inserted on object tracks.

The total number of objects that can be routed via a MADI stream differs when using a mixing console that supports 56 channels (varispeed) only.

Table 3-1 Dolby Atmos Specification for Pro Tools

<table>
<thead>
<tr>
<th>Audio Elements</th>
<th>Playback Voices (In Pro Tools)</th>
<th>Multichannel Mixing Format</th>
<th>Channels and Track Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bed</td>
<td>10</td>
<td>9.1</td>
<td>L, C, R, Lss, Rss, Lsr, Rsr, and LFE; Lts and Rts (on separate bus)</td>
</tr>
<tr>
<td>Objects</td>
<td>Up to 118</td>
<td>Mono or stereo</td>
<td>C for mono; L and R for stereo</td>
</tr>
<tr>
<td>Total</td>
<td>Up to 128</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Audio Elements

There are two types of content for Dolby Atmos: bed and objects. The bed refers to channel-based premixes or stems (including their multichannel panning). Objects refer to mono or stereo soundtrack content. Objects have dedicated panning via Dolby Atmos metadata (provided by Panner plug-ins and their automation playlists).

Playback Voices (In Pro Tools)

This is the total number of audio streams that you can route to and from Pro Tools audio tracks, and physical audio outputs and inputs on your Pro Tools audio interfaces. In a Dolby Atmos system, the primary Pro Tools audio interfaces are two Avid HD MADI interfaces. This is the recommended configuration when working in Pro Tools directly.
When working with a mixing console (such as an Avid System 5 or AMS Neve DFC), there are typically several Pro Tools playback machines with smaller source sessions.

**Multichannel Mixing Format**

This is the number and type of channel outputs required for Dolby Atmos. In Pro Tools, the 9.1 format represents the bed, and is mapped as a 7.1 bed output, plus a stereo overhead output. Objects are mapped individually to mono and stereo outputs.

**Channels and Track Layout**

These are the default channel assignments (or mono subpaths) and their ordering (for example, in channel outputs and meters). Channels are configured in I/O Setup and are available for use as track outputs and sends in the session. For greater-than-stereo multichannel tracks, Pro Tools internal routing uses standard film channel ordering.

---

**Note:** Channel layout for Pro Tools outputs and meters do not match the ordering of the MADI inputs of the Dolby RMU. Internally, Pro Tools uses film channel ordering. RMU Inputs use SMPTE/ITU channel ordering. See [Routing Pro Tools Physical Outputs to RMU MADI Inputs](#).

---

### 3.1.2 Considerations When Routing Pro Tools Physical Outputs to RMU MADI Inputs

The Dolby RMU MADI inputs use SMPTE/ITU channel ordering. When configuring Pro Tools physical output paths in I/O Setup, order the outputs to match the ordering of the MADI inputs of the RMU, according to the assignments listed in the following table.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11 to 128</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>R</td>
<td>C</td>
<td>LFE</td>
<td>Lss</td>
<td>Rss</td>
<td>Lsr</td>
<td>Rsr</td>
<td>Lts</td>
<td>Rts</td>
<td>C for mono object tracks; L and R for stereo object tracks</td>
</tr>
</tbody>
</table>

---
These assignments are defined in the I/O Setup Output page.

![Audio Routing Diagram](image)

### 3.2 Pro Tools Session Requirements

A Pro Tools session for Dolby Atmos has the following requirements:

- To ensure communication between the RMU and Panner plug-ins in Pro Tools, as well as with the Dolby Atmos Monitor application, power on the system as follows:
  a. Power on the Pro Tools machine.
  b. Power on the Dolby RMU.
  c. Launch the renderer on the RMU.
  d. Launch the Dolby Atmos Monitor application on the Pro Tools machine.
  e. Connect the Monitor application to the Dolby RMU network.
  f. Launch Pro Tools and open a session.

- 48 kHz session sample rate:
  - The Dolby RMU supports 48 kHz sessions only. If working with different sample rates during sound creation or premixing, you need to change the session sample rate prior to working with the RMU.
3.3 Authoring in a Pro Tools Session

Authoring for Dolby Atmos in a Pro Tools session consists of creating, mixing, and managing audio material designated as beds and objects. A completed Pro Tools session for Dolby Atmos is a mix of beds and objects (including their metadata) sent to the Dolby RMU for rendering.

Use one or more sessions to support the authoring process and creation of the print master for exhibition.

Dolby Atmos mixes are typically created from individual Pro Tools sessions (for example, for each "reel" of the soundtrack). You can combine the reels in a single Pro Tools session, and print master the session as a full soundtrack. Alternatively, you can print master each reel separately, and then stitch them together in the RMU to form the full soundtrack.

3.3.1 Working with the Bed

In Pro Tools, working with the bed for a Dolby Atmos mix is generally the same as traditional methods for working with multichannel stems for a surround or stereo format. One or more tracks for a given stem (such as the music stem) are still output (or sent) to a multichannel format. With Dolby Atmos, this is the 7.1 portion of the bed. Additionally, bed material for overhead speakers is output to stereo. Surround and stereo panning are still performed using the Pro Tools Panner Grid, pan automation editing, or a Pro Tools hardware control surface.

The primary difference when working with bed material in the Dolby Atmos format is configuring the session I/O Setup and signal routing so that the session meets the Dolby Atmos specification and provides ten channels of audio to the Dolby RMU. Use the Dolby Atmos Monitor application while authoring in Pro Tools to listen to the RMU output of the bed, objects, and the effect of object metadata, in real time. In addition, it is important to decide which material is suited for the bed (7.1 output or stereo overheads), as opposed to material that would benefit from precision positioning that can be applied to objects.
3.3.2 Working with Objects

Pro Tools tracks for objects in a Dolby Atmos mix use mono and stereo signal paths, which, like the bed, are also configured in the session I/O Setup. However, instead of using Pro Tools built-in mono and stereo panning controls on each object track, you insert a Dolby Atmos Panner plug-in and use its controls. The Dolby Atmos Panner plug-in provides controls to write automation for Dolby Atmos metadata (pan position and other object metadata) to the track automation playlist. For example, the metadata places the object at a single point in a zone (or speaker zone), or moves it across one or more zones.

Typically, Dolby Atmos metadata is applied to audio at the RMU. Metadata in the automation playlist does not affect the sound within the Pro Tools session. Use the Dolby Atmos Monitor application while authoring in Pro Tools to listen to the RMU output of the bed, objects, and the effect of metadata, in real time.

**Note:** To hear audio from an object track at the RMU, the object must exist in Pro Tools (that is, the track Panner plug-in must have an object number assigned to it), and I/O Setup must be configured for Dolby Atmos.

When the object exists, auxiliary input tracks and other tracks that route to the same object output path will also output at the RMU.

The combination of objects supported by paths in the I/O Setup and primed for use with Dolby Atmos Panner plug-ins ensures that the session meets the Dolby Atmos specification and provides audio and metadata for up to 118 objects to the RMU for rendering. As noted previously, it is important to designate as an object any material that benefits from precision panning.

3.4 Creating a Pro Tools Session for Dolby Atmos

Apply the Dolby Atmos specification for Pro Tools when creating a new Pro Tools session, or when reconfiguring an existing session (for example, when changing a 7.1- or 5.1-channel session to a Dolby Atmos session).

3.4.1 Creating a New Pro Tools Session

This section provides steps for creating a Pro Tools session in the Dolby Atmos standard timecode rate (24 fps). If you are working with 23.98 fps, see Working with 23.98 fps.

To create a new Pro Tools session for Dolby Atmos authoring:

1. Choose **File > New Session**.
2. Select the **Create Blank Session** option.
3. Select the audio file type, sample rate (48 kHz), and desired bit depth.

You can work with different sample rates during sound creation or premixing, but you must change the session sample rate prior to working with the RMU.
4. From the **I/O Settings** menu, select **Stereo Mix**.
   You can create the required multichannel output and bus paths for Dolby Atmos after the session is opened.

5. Click **OK**.
   The new session launches.

6. Choose **Setup > Session**.

7. In the **Format** section, set **Timecode Rate** to 24 fps.

8. In the **Timecode Settings** section:
   a. Set **Audio Rate Pull Up/Down** to **None**.
   b. Set **Video Rate Pull Up/Down** to **None**.

9. Create **output** and **bus paths** in the **I/O Setup**, per the Dolby Atmos specification.

10. **Create tracks** to support beds and objects, per the Dolby Atmos specification.

### 3.4.2 Reconfiguring an Existing Session

To reconfigure an existing Pro Tools session for Dolby Atmos authoring:

1. For 24 fps timecode sessions, confirm the settings:
   - Session **Sample Rate**: 48 kHz
   - **Timecode Rate**: 24 fps
   - **Audio Rate Pull Up/Down**: None
   - **Video Rate Pull Up/Down**: None

2. For 23.98 fps sessions, see **Working with 23.98 fps**.

3. Redo **output** and **bus paths** in **I/O Setup**, per the Dolby Atmos specification.
4. In the Pro Tools session, change existing tracks (and create new tracks, as needed) to support beds and objects, per the Dolby Atmos specification.

### 3.4.3 Working with 23.98 fps

When working with a timecode rate of 23.98 fps, you can apply pull up/down and sample-rate conversion at the following times:

- When recording the mix session
- Before print mastering the session

The advantage of applying pull up/down when recording the session is that the Pro Tools print master is in the identical format as the RMU master (48 kHz, 24 fps), and sample-rate conversion is applied during the mix (instead of during print-master recording).

#### Applying Pull Up/Down and Sample-Rate Conversion When Recording a 23.98 fps Session

To apply pull up/down and sample-rate conversion when recording a mix session in 23.98 fps:

1. Launch the session.
2. Choose Setup > Session.
3. In the Format section, set Sample Rate to 48 kHz.
4. In the Format section, set the Timecode Rate to 23.98 fps.
5. In the Timecode Settings section:
   a. Set Audio Rate Pull Up/Down to 0.1% Down.
   b. Set Video Rate Pull Up/Down to None.
6. Choose Setup > Hardware, and enable sample-rate conversion for both HD MADI interfaces.

#### Applying Pull Up/Down and Sample-Rate Conversion Before Print Mastering a 23.98 fps Session

To apply pull up/down and sample-rate conversion before print mastering a 23.98 fps session to the RMU:

1. Launch the session.
2. Choose Setup > Session.
3. In the Format section, set Sample Rate to 48 kHz.
4. In the Format section, set the Timecode Rate to 24 fps.
5. In the Timecode Settings section:
   a. Set Audio Rate Pull Up/Down to 0.1% Up.
   b. Set Video Rate Pull Up/Down to 0.1% Up.
6. Choose Setup > Hardware, and enable sample-rate conversion for the output of both HD MADI interfaces.
3.5 Configuring I/O Setup

You must configure Pro Tools I/O and signal routing for Dolby Atmos after creating a new session for Dolby Atmos, or when reconfiguring an existing surround session to Dolby Atmos. Pro Tools I/O and signal routing will be determined by the paths defined in the I/O Setup.

Pro Tools sessions for Dolby Atmos should have their I/O Setup (output and bus mapping) configured for beds and objects, as listed in the following table.

### Table 3-3 I/O Setup Specification for Dolby Atmos

<table>
<thead>
<tr>
<th>Audio Elements</th>
<th>Number of Buses</th>
<th>Multichannel Format</th>
<th>Buses Mapped to Output Name (Recommended Names)</th>
<th>Buses Mapped to Output Physical Channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beds</td>
<td>One or more</td>
<td>7.1</td>
<td>Atmos 7.1 Bed</td>
<td>Channels 1–8 of first HD MADI interface</td>
</tr>
<tr>
<td>Beds (overheads)</td>
<td>One or more</td>
<td>Stereo</td>
<td>Atmos OH Bed</td>
<td>Channels 9–10 of first HD MADI interface</td>
</tr>
<tr>
<td>Objects</td>
<td>Up to 118</td>
<td>Mono or stereo</td>
<td>Object 1 (and so on)</td>
<td>Channels 11 and higher of two HD MADI interfaces</td>
</tr>
</tbody>
</table>

**Note:** We recommend you create an I/O Setup for Dolby Atmos in Pro Tools and export it for future use. See Pro Tools documentation for steps on how to export and import settings in the I/O Setup.

**Note:** For better flexibility when working with objects, create stereo object outputs with mono subpaths.
3.5.1 Configuring Output

In **I/O Setup**, create output paths for Pro Tools tracks and map them to physical outputs on the HD MADI interfaces.

![Image of I/O Setup output, configured for Dolby Atmos](image)

**Figure 3-4** I/O Setup Output, Configured for Dolby Atmos

To configure the **I/O Setup** output for Dolby Atmos:

1. In the Pro Tools session for Dolby Atmos, open the **I/O Setup** dialog and click the **Output** tab.
2. Set **5.1 Path Order** to **L R C LFE Ls Rs** (SMPTE/ITU).
   This ensures that new 5.1 output paths default to mapping the physical outputs of the first HD MADI interface to the same channel ordering as the RMU inputs.
3. For the 7.1 path:
   a. Create a new 7.1 path.
   b. Name it **Atmos 7.1 Bed**.
   c. Map it to HD MADI channels 1–8.
4. For the overheads:
   a. Add a stereo path (or use an existing stereo path).
   b. Name it **Atmos OH Bed**.
   c. Map it to HD MADI channels 9–10.
5. For objects:
   a. Add (or use existing) mono and stereo paths for objects.

   **Note:** For more flexibility, use stereo object outputs with mono subpaths (created on the Bus page). This configuration allows for using the output on stereo or mono object tracks.

   b. Name them **Object x** (for mono) and **Object x-x** (for stereo).

   c. Map them to respective HD MADI channels (starting with channel 11).

   **Note:** To hear audio from an object track at the RMU, the object must exist in Pro Tools (that is, the track Panner plug-in must have an object number assigned to it), and **I/O Setup** must be configured for Dolby Atmos.

   When the object exists, auxiliary input tracks and other tracks that route to the same object output path will also output at the RMU.

6. Click **OK**.

For more information on how to create output paths in Pro Tools, refer to Pro Tools documentation.

### 3.5.2 Configuring Input

There is no required **I/O Setup** input configuration for Dolby Atmos.
3.5.3 Bus Mapping

Buses for output paths are automatically created and mapped after output paths have been created in the I/O Setup dialog.

Figure 3-5 I/O Setup Bus Mapping, Configured for Dolby Atmos

To see I/O Setup bus mapping for Dolby Atmos:

1. In the Pro Tools session for Dolby Atmos, open the I/O Setup dialog.
2. Click the Bus tab.

For more information on bus paths in Pro Tools, refer to Pro Tools documentation.

3.6 Configuring Tracks and Signal Routing

A Pro Tools session for Dolby Atmos includes a combination of audio beds (in multichannel audio tracks) and objects (in mono or stereo audio tracks). You must configure audio tracks for Dolby Atmos after creating a new session for Dolby Atmos, or when reconfiguring an existing surround session to Dolby Atmos.
Use the following layout for a Dolby Atmos session:

- One or more audio tracks for output bed stems, in 7.1 track format, with 7.1-channel output path
- One or more audio tracks for the overheads that are part of the beds, in stereo track format, with stereo output path
- Audio tracks for objects, in mono or stereo format, with mono or stereo output path

The following figure shows how to create tracks and lay them out to support the Dolby Atmos mix.

![Figure 3-6 Dolby Atmos Tracks and Track Main Outputs Set to Dolby Atmos Paths](image)

In the figure, music, dialogue, and effects beds (stems) are mixed to 9.1 (as separate 7.1 and stereo overhead bed paths), while stereo and mono objects have their own tracks. Each object track has a Panner plug-in to define the Dolby Atmos metadata that is sent to the RMU. (See Using the Panner Plug-in to Position Objects.)
Note: Audio from an object track outputs at the RMU only when the object exists in Pro Tools and has the proper I/O Setup routing.

Alternatively, you can route multichannel sends (instead of track main outputs) to a multichannel path. See Pro Tools documentation for more information.

Note: We recommend you create a Pro Tools session template for Dolby Atmos (including track layout, signal routing, and plug-ins) for future use. See Pro Tools documentation for steps on how to create session templates.

3.7 Considerations for Hearing Dolby Atmos Audio

Bed and object audio from Pro Tools are routed to the Dolby RMU inputs, and are then routed to the RMU outputs.

To hear bed and object audio, keep in mind the following:

- Bed tracks route to channel outputs that are mapped to the MADI I/O, as configured in I/O Setup, and then route to the Dolby RMU for rendering. Monitor bed audio from the Dolby RMU. Bed audio material outputs from the first ten channel outputs of the Dolby RMU.
- Object tracks route to channel outputs that are mapped to MADI I/O, as configured in I/O Setup. To hear audio from the Dolby RMU output, the object track in Pro Tools must have a Panner plug-in with an object number assignment.
- The Monitor application must be communicating with the Dolby RMU renderer (via a host name or IP address) and have a valid room configuration loaded.
- In the Monitor application, the following controls affect audio presence or level:
  - The linear timecode (LTC) button in the transport: This button must be disabled (unlit) for Pro Tools to output audio to the Dolby RMU, for live monitoring.
  - The mute button in the transport: This button must be disabled for audio to be present at the RMU.
  - Muted speakers in the room configuration: Any speaker that is muted results in no audio from that speaker. If all active speakers are muted, no sound will be heard from the Dolby RMU.
  - The DIM button in the transport: When enabled, this button lowers the volume of signal at the Dolby RMU output by −20 dB. Low level content may be inaudible.
  - The output attenuation (ATTEN) control in the transport: When this control is set to −Inf (negative infinity), audio is effectively muted. The attenuator is not displayed by default. If it is not displayed, press <Control>+<Option>+<Command>+<A> to display the control and verify it is not set to −Inf.
In the Dolby RMU web client, the following controls affect audio presence or level:

- The **MUTE** button at the top of the web client: This button must be disabled for audio to be present at the RMU.
- The **global gain (dB)** control in the settings screen: When this control is set to –60 dB, audio is effectively muted.
- The **DIM** button at the top of the web client: When enabled, this button lowers the volume of signal at the Dolby RMU output by –20 dB. Low level content may be inaudible.

3.8 Working with Multiple Pro Tools Systems

You can use multiple Pro Tools machines in a Dolby Atmos system. Each machine needs to be connected to the RMU network.

When recording from a Pro Tools source machine to a Pro Tools destination machine, metadata is routed directly from the source to the recorder. This removes the processing overhead and latency introduced by the RMU processing first.

When working with multiple Pro Tools machines, consider the following:

- The Pro Tools destination (or recorder) machine and any additional Pro Tools playback machines or other clients that communicate to the RMU must be connected to the RMU network and configured for use.
- Pro Tools machines must be synced together. Common solutions include chasing LTC from a timecode generator, slaving to Sony® P2 machine control, or using the Avid Satellite Link option. If working with Avid Satellite Link software, consider configuring the Pro Tools recorder machine as the first (administrator) machine, and playback machines as subsequent (nonadministrator) machines.
- Use the Panner plug-in **Recorder mode** to record metadata from multiple Pro Tools playback machines into a single Pro Tools record machine.

**Note:** Panner plug-ins in Recorder mode (on the Pro Tools recorder machine) do not set their object ID to active in the RMU. Only Panner plug-ins that are not set to be in Recorder mode (such as those in Pro Tools playback machines) declare their object as active in the RMU. If an object ID in the playback machine is not declared as active, the Recorder mode plug-in with the same object ID will no longer record metadata for that object ID.

- Do not use the same object number for Panner plug-ins in multiple playback machines that are used for the same print master. Divide object numbers among the various playback machines. It is possible to assign Panner plug-ins to the same object from different machines, which would corrupt the panning automation.
- When configuring a record machine to record Dolby Atmos metadata from one or more playback machines, make sure the record machine has the same number of Panner plug-ins, each with the same object number, as configured in the playback machines.
Using the Dolby Atmos Monitor Application

The Dolby Atmos® Monitor application is a stand-alone application for audio and visual monitoring of the Dolby® RMU as it renders audio and Dolby Atmos metadata. The Monitor application includes controls for print-master recording and print-master playback. During monitoring or playback, you can also use the Monitor application to re-render to either 7.1 or 5.1 surround formats.

You can monitor the audio signals from the RMU outputs when listening live to Pro Tools® material routed to the RMU, or when using the Monitor application to record a Dolby Atmos print master or play it back. All audio monitoring includes real-time rendering of Dolby Atmos metadata. Additionally, controls are provided to mute individual speakers or groups of speakers in the room configuration, or all RMU output.
Using the Dolby Atmos Monitor Application

The Monitor application provides visual feedback from the RMU, including status and metering information of Dolby Atmos objects, bed material, and speakers for the targeted room configuration.

For installation information, see Installing the Dolby Atmos Authoring Tools.

4.1 Before Using the Monitor Application

Before using the Monitor application for the first time, verify the Dolby Atmos system setup, as directed by your Dolby Content Services representative or as described in the manual for your Dolby Rendering and Mastering Unit. Setup verification includes the following:

- At the RMU:
  - The RMU must have a valid IP address.
  - A .dac file generated with Dolby Atmos Designer must be present on the RMU local drive. This file includes room configuration and other data required for live monitoring and other Dolby Atmos tasks.

- At the Pro Tools system:
  - The Pro Tools system must be connected to the RMU (via two Avid® HD MADI interfaces).
  - One or more Pro Tools sessions must be configured for Dolby Atmos use.
  - A copy of the Monitor application must be installed. This is required for establishing communication between Dolby Atmos Panner plug-ins in Pro Tools and the RMU. See Communicating from the Pro Tools System.

4.2 Launching the Monitor Application

To launch the Monitor application:

- Double-click the Dolby Atmos Monitor application file (located in /Applications/Dolby).

Figure 4-2  Dolby Atmos Monitor Application Icon
4.3 Waiting for Room Configuration Message

When you first launch the Monitor, the Waiting for Room Configuration message displays.

![Waiting for Room Configuration Message](image)

Figure 4-3 Waiting for Room Configuration Message in the Default Monitor Application Window

After enabling communication with the RMU, and then loading a room configuration with the Dolby RMU web client, the message is replaced with the speakers for the room configuration.

The room configuration and other data are in a .dac zip file on the RMU. If the file is not loaded (or the Monitor application is not communicating with the RMU), the Monitor application continues to display a Waiting for Room Configuration message.

4.4 Enabling Communication with the RMU

Enable communication between the Monitor and the RMU in one of two ways:

- From the Pro Tools system (required to enable communication between Dolby Panner plug-ins in Pro Tools and the RMU)
- From other devices
### 4.4.1 Enabling Communication from the Pro Tools Computer (Required)

You must use the Monitor application located on the Pro Tools computer for Dolby Atmos to initially enable communication between the Monitor application and the RMU. This is because the local Monitor application also automatically enables communication between Panner plug-ins in Pro Tools and the RMU. Once this connection is made, it is saved in the computer preferences, and you can keep the Monitor application open or closed without disabling the plug-in to RMU connection. However, Pro Tools must remain open so that Dolby Atmos metadata is actively sent to the RMU.

You can subsequently use the Monitor application on the Pro Tools system, or a dedicated one located on another device, to enable communication between the Monitor application and the RMU for monitoring.

To enable initial communication between the Monitor application and the RMU, including required communication between Panner plug-ins and the RMU:

1. Power up the RMU.
2. Power up the computer running Pro Tools.
3. On the computer that runs Pro Tools sessions used for Dolby Atmos, launch the Monitor application (located in /Applications/Dolby).

![Default Monitor Application Window (When Not Communicating from Pro Tools)](image)

**Figure 4-4** Default Monitor Application Window (When Not Communicating from Pro Tools)
4. Click **Dolby Atmos Monitor > Preferences** (Mac) or **Tools > Preferences** (Windows).

![Dolby Atmos Preferences](image)

Figure 4-5  Dolby Atmos Preferences

5. In the **Server IP or Hostname** section, click **Edit**.

6. Enter the Renderer software IP address or host name, or select an item for the drop-down menu (if any), and then click **Select**.

**Note:** You can also access the **Enter Hostname** dialog in the **Renderer** section of the Monitor application window by clicking in the **Renderer** section.

7. Verify communication with the RMU, and then verify the room configuration.

8. Close the Monitor application, if desired (for example, if intending to do subsequent monitoring at a different time or from a different device).

9. Repeat steps 5–9 for Monitor applications on other Pro Tools machines.

### 4.4.2 Enabling Communication from Other Devices (Optional)

You can also locate one or more dedicated Monitor applications on devices other than the Pro Tools computer for Dolby Atmos. In this scenario, each secondary Monitor application allows for enabling communication with the Dolby RMU for RMU monitoring only. They do not establish communication between the Panner plug-ins in Pro Tools and the RMU.

**Note:** Communication between Panner plug-ins in Pro Tools and the RMU must first be established on the Pro Tools computer. See **Communicating from the Pro Tools System**.

To enable communication between a secondary Monitor application and the RMU only:

1. If communication between Panner plug-ins in Pro Tools and the RMU has not been enabled, do so at this time. See **Enabling Communication from the Pro Tools Computer**.

2. On a device dedicated as a secondary Monitor application, install a copy of the Monitor application.

3. On the same device, launch the Monitor application (located in /Applications/Dolby).

4. Click **Dolby Atmos Monitor > Preferences** (Mac) or **Tools > Preferences** (Windows).

5. In the **Server IP or Hostname** section, click **Edit**.

6. Enter the Renderer software IP address or host name, or select an item for the drop-down menu (if any), and then click **Select**.

---

Authoring for Dolby Atmos® Cinema Sound Manual 33
Using the Dolby Atmos Monitor Application

Note: You can also access the Enter Hostname dialog in the Renderer section of the Monitor application window by clicking in the Renderer section.

7. Verify communication with the RMU, and then verify the room configuration.

4.4.3 Verifying Communication with the RMU

When communication with the RMU is successful, the Renderer section provides two indications. The renderer IP or host name will appear in the Renderer section, and the connection status light will turn green.

![Successful Connection Between Monitor and RMU Host Name](image)

To verify communication with the RMU:

- Verify that the renderer IP or host name displays in the Renderer section and the connection status light is green.

Troubleshooting Communication with the RMU

If the connection status light is red after attempting to enable communication with the RMU, the connection was unsuccessful.

Troubleshoot communication with the RMU by doing the following:

- Verify the IP address or host name.
- Check your Ethernet connections.
- Repeat the steps for enabling communication with the RMU.

4.5 Loading a .dac Room Configuration File (Required)

Before you can use the Monitor application and Dolby RMU web client for authoring, you must load a Dolby Atmos room configuration (.dac) file into the Dolby RMU.

Use the Dolby Atmos Designer software application to generate the .dac file for your mix stage. This file includes the room configuration and other data. For more information about the .dac file and Dolby Atmos Designer, see the Dolby Rendering and Mastering Unit for Cinema User Manual.

To load a .dac file:

1. Launch a browser that supports the Dolby RMU web client, and type in the IP address for the Dolby RMU.
The Dolby RMU web client displays.

![Dolby RMU Web Client, Default Window](image)

**Figure 4-7**  Dolby RMU Web Client, Default Window

2. In the Dolby Atmos web client, load the room configuration (.dac file):
   a. In the RMU section of the navigation bar, click the maintenance menu.
   b. At the top of the settings management section, click the restore button.

![Setting Management Section of the Maintenance Screen](image)

**Figure 4-8**  Setting Management Section of the Maintenance Screen

   c. Click the browse button.
   d. Navigate to the location of the .dac file that you want to load, select it, and click Choose.
Using the Dolby Atmos Monitor Application

4.5.1 Verifying the Room Configuration File

When communication with the RMU is successful, and you have successfully loaded the room configuration on the RMU, the room configuration should appear in the Monitor application window.

The room configuration provides a visual representation of speakers, as configured for the Dolby Atmos room.

To verify the room configuration:

- In the Monitor, verify that the Waiting for Room Configuration message has been replaced with the speakers for the room configuration (which was loaded with the Dolby RMU web client).
Troubleshooting a Room Configuration That Does Not Load

If the *Waiting for Room Configuration* message does not go away (and you have successfully enabled communication with the RMU), do the following:

- Verify that a valid .dac file has been created with Dolby Atmos Designer (as directed by your Dolby Content Services representative, or as described in the manual for your Dolby Rendering and Mastering Unit).
- Verify that the file has been correctly loaded with the Dolby RMU web client.

4.6 Rendering

Rendering refers to the process and algorithms that the RMU uses to render, or play audio beds and objects while positioning them to, or across, up to 64 speakers. Positioning for beds is based on multichannel mixes. Positioning for objects is based on Dolby Atmos metadata.

The Monitor application allows for rendering to the Dolby Atmos format in all operation modes, or re-rendering to a surround format (such as 7.1 or 5.1 channels) when listening to a mix in the Monitor Live mode or when playing back a Dolby Atmos print master.

- During monitoring, the RMU renders audio and metadata from Pro Tools and any client applications (such as the System 5 Panner).
- During print mastering, the RMU renders audio and metadata from Pro Tools and any client applications (such as the System 5 Panner).
- During playback, the RMU renders material from the print master (located on the RMU).

4.6.1 Rendering to the Dolby Atmos Format

By default, the Monitor application sets the RMU to render in the Dolby Atmos format. If the setting of the rendering mode has been changed to re-render the Dolby Atmos format to a surround format (such as 7.1 or 5.1 channels), you can change it back to Dolby Atmos in the Monitor application window or the Monitor application preferences.

To change the rendering mode to Dolby Atmos:

1. Launch the *Select Rendering Mode* dialog to reveal rendering selections by doing one of the following:
   - Click in the *Mode* section of the Monitor application window.
   - Click *Dolby Atmos Monitor > Preferences* (Mac) or *Tools > Preferences* (Windows), and then click *Edit* in the *Mode* section.
2. In the *Select Rendering Mode* dialog, click *Dolby Atmos*.
3. Leave *Objects Only Mode* unchecked, unless specifically choosing to render object audio only. In Objects Only mode, bed material is effectively muted.
4. Click **Select**.

**Note:** With the Monitor application in focus, pressing <D> on the keyboard toggles between Dolby Atmos, 7.1, and 5.1 rendering modes.

### 4.6.2 Re-rendering to a Surround Format

To re-render to a surround format, change the rendering mode to the desired surround format:

1. Optional: Set the **re-render options** in the Dolby RMU web client, if needed.
2. Launch the **Select Rendering Mode** dialog to reveal rendering selections by doing one of the following:
   - Click in the **Mode** section of the Monitor application window.
   - Click **Dolby Atmos Monitor > Preferences** (Mac) or **Tools > Preferences** (Windows), and then click **Edit** in the **Mode** section.
3. In the **Select Rendering Mode** dialog, click the desired rendering mode.
4. Leave **Objects Only Mode** unchecked, unless specifically choosing to re-render object audio only. In Objects Only mode, all beds are effectively muted.
5. Click **Select**.

**Note:** With the Monitor application in focus, pressing <D> on the keyboard toggles between Dolby Atmos, 7.1, and 5.1 rendering modes.

### Re-rendering and Clip Level

When re-rendering in 5.1 and 7.1, Monitor application meters use a lower clip threshold (~3 dB) to replicate playback in a traditional room where the sound arrays are calibrated to 82 dB.

The RMU includes a +3 dB boost to signal in the surrounds (Ls and Rs in 5.1; and Lss, Rss, Lb, and Rb in 7.1) prior to clipping and metering, and then a cut of ~3 dB after that, but before the audio output. This results in the output clipping at a 3 dB lower threshold, and the metering showing a 3 dB higher signal. This also results in the same audio level output from the RMU to support playback in a room with the surrounds calibrated to 85 dB.

### Re-render Options

Before re-rendering to a surround format, you can set re-render options in the Dolby RMU web client.

The renderer provides the following options for re-rendering to 7.1 or 5.1:

- **Surround Gain Re-render Option**
- **Bass Management Routing Re-render Options**
Setting Web Client Re-render Options

To set web client re-render options:

1. In the Dolby RMU web client, click the **re-render** menu in the **project** section of the navigation bar.

   The project re-render screen displays.

2. Set re-render options as desired.

   Depending on the option, changes are set immediately when selected, or after you type and press <Enter>.

3. On the Monitor application, change the rendering mode to the desired format: 7.1 or 5.1.

4. Proceed with live monitoring, or print-master playback.

Surround Gain Re-render Option

The renderer provides a gain option for re-rendering to 7.1 or 5.1:

- **re-render surround gain (dB)**: Sets the trim level for the surround speakers when in a surround re-render mode (7.1 or 5.1). The range is –60 to 10 dB. Make changes immediately with the up/down arrow keys, or type in a value, and then press <Enter>.

   When re-rendering to 7.1, the trim is applied to Lss, Rss, Lb, and Rb speakers. When re-rendering to 5.1, the trim is applied to Ls and Rs speakers.

**Note:** With the re-render surround gain set to 0, the re-render process actually outputs the surrounds at +3 dB to account for 7.1 and 5.1 rooms being configured with surrounds at 82 dB, as opposed to 85 dB in a Dolby Atmos mix stage.

Bass Management Routing Re-render Options

The renderer provides the following bass management routing options for re-rendering to 7.1 or 5.1:

- **re-render surround bass handling**:
  - **discard bass**: If selected, discards frequencies below the bass threshold frequency.
  - **bass-manage to LFE**: If selected, routes audio content below the bass threshold frequency to the LFE channel, rather than to the bass management speakers that were assigned to speakers for rendering Dolby Atmos (via the Dolby Atmos Designer). This prevents loss of bass material.

When re-rendering to 7.1, the audio content below the bass threshold frequency is applied to Left Side Surround (Lss), Right Side Surround (Rss), Left Back (Lb), and Right Back (Rb) speakers. When re-rendering to 5.1, the audio content below the bass threshold frequency is applied to Left Surround (Ls) and Right
Surround (Rs) speakers. For both 7.1 and 5.1, the audio content below the bass threshold frequency, plus the bed LFE, are summed into LFE.

Make changes with the radio buttons. Changes are applied immediately.

- **bass threshold frequency (Hz)**: Sets the frequency at which bass is discarded or routed to LFE, depending on the re-render surround bass handling setting. The range is 0 Hz and above. The default is 120 Hz.

  Make changes immediately with the up/down arrow keys, or type in a value, and then press <Enter>.

  When bass threshold frequency is specified (with a valid range of 0 and above, in Hz), the renderer applies a crossover at the specified frequency, and the bass content is preserved and summed into the LFE, or discarded. Typical settings are 50–150 Hz. The bass content is cut by 10 dB to account for the LFE being calibrated 10 dB higher than other speakers.

  If there is more than one speaker in the LFE array, and **bass-manage to LFE** is enabled, the energy is distributed to all the LFE array speakers.

---

**4.7 Monitor Application Operation Modes**

The Monitor application has three operation modes: live monitoring, print master, and playback.

All three modes allow for monitoring the RMU status and metering, the effect of Dolby Atmos metadata on objects, and the room speaker configuration. Each mode also allows for monitoring object audio only, as well as muting individual speakers or groups of speakers in the room configuration, or all RMU output. See [Monitoring with the Dolby Atmos Monitor Application](#).

Each operation mode has a primary use:

- **Live monitoring** allows for monitoring the audio signals from the RMU outputs when mixing and listening live to Pro Tools material in the Dolby Atmos format, or a surround format (such as 7.1 or 5.1 channels).

- **Print master** allows for recording and monitoring a Dolby Atmos print master.

- **Playback** is the default operation mode after communication is enabled and a room is loaded. It allows for playing back (or monitoring playback of) a Dolby Atmos print master in the Dolby Atmos format, or a surround format (such as 7.1 or 5.1 channels).

The Monitor application works in tandem with the Dolby RMU web client, as described in this manual. For more information on the web client, see the manual for your Dolby Rendering and Mastering Unit.

**4.7.1 Live Mode Monitoring of Pro Tools**

Live mode allows for monitoring the audio signals from the RMU outputs when listening live to Pro Tools material being rendered in the Dolby Atmos format, or re-rendered to a surround format (such as 7.1 or 5.1 channels). By default, Live mode has no Monitor transport controls engaged.
All Monitor metering, displays, and controls are functional in Live mode.

Note: During Live mode monitoring, make sure the Monitor LTC button is off. This ensures that you are receiving live audio from the Pro Tools session.

4.7.2 Recording a Dolby Atmos Print Master

Use the Monitor application to record (generate) a Dolby Atmos print master. The print master contains the bed audio (9.1), up to 118 objects, and Dolby Atmos metadata.

Note: The setting of the rendering mode in the Monitor application does not affect the print-master recording. The rendering mode affects only what is being listened to during recording. A print master created with the Monitor application is always a Dolby Atmos print master.

Print-master management is performed via the Dolby RMU web client. The project drive specified when creating the project that the print master is added to, includes the folder that the print master will be recorded to. See the manual for your Dolby Rendering and Mastering Unit for more information about projects and managing print masters, including how to stitch (or combine) multiple-source Dolby Atmos print masters into a single print master.

To record a Dolby Atmos print master:

1. In the Dolby RMU web client, make active an unsaved print master:
   a. Open a saved project. See the manual for your Dolby Rendering and Mastering Unit for information on projects.
      
      Note: A project that has never been saved must be saved prior to recording a new print master.
   b. Click the media button.
   c. Click the print masters tab to display the list of project print masters.
   d. In the project print masters and .mxf dialog, do one of the following:
      - Select (highlight) an unsaved print master (that is, a print master that has no media). A print master that has no media displays no media icon in the second column.
      - If there are no unsaved print masters, add a new print master and select (highlight) it.
      See the manual for your Dolby Rendering and Mastering Unit for information on adding a print master.
   e. Click the set print master / .mxf button.
      The dialog automatically closes.
2. In the Monitor application transport (or Dolby RMU web client transport), prepare the renderer for recording:
   a. Click (highlight) LTC to set the RMU to chase timecode from Pro Tools (or the bus).
   b. Click (highlight) O to ready the RMU for recording a print master.

3. In Pro Tools, start playback.

4. When the material has completed, stop playback in Pro Tools.

On the destination RMU drive, the print-master recording pass produces:

- Ten mono .wav files, which make up the 9.1 bed
- One .prm and one .wav file per object
- One dub_out.rpl file

See the manual for your Dolby Rendering and Mastering Unit for more information, including how to stitch (or combine) multiple-source Dolby Atmos print masters into a single print master.

### 4.7.3 Punching In and Out of a Print-Master Recording

You can punch in and out of recording a Dolby Atmos print master. This is useful when you want to update one or more sections of a print master with new audio or metadata.

**Note:** Before doing a punch in and out recording pass, do not add new objects to the Pro Tools session. If you need to add new objects to the session, record a new print master with the new objects before doing the punch in and out.

Print-master management is performed via the Dolby RMU web client. The project drive specified when creating the project that the print master is added to, includes the folder that the print master will be recorded to. See the manual for your Dolby Rendering and Mastering Unit for more information about managing projects and print masters.

When punching in and out of recording a print master, keep in mind the following:

- The first punch-in determines the beginning of the file. You cannot subsequently punch in before the first punch.
- If you are recording to an existing print master, you can start from anywhere in the timeline as long you do not punch in before or after the print master start and end times.
- It is not possible to have gaps in the file. Punch-ins must be done in a linear fashion. You cannot jump to a later point in the timeline and punch in or out.

To punch in and out of recording to update a Dolby Atmos print master:

1. In the Dolby RMU web client, make active a print master that has media:
   a. Open a project.
      See the manual for your Dolby Rendering and Mastering Unit for information on projects.
   b. Click the media button.
c. Click the **print masters** tab to display the list of project print masters.

d. In the **project print masters and .mxfs** dialog, select (highlight) a print master that has media.

   A print master that has media displays a media icon in the second column.

   e. Click the **set print master / .mxf** button.

   The dialog automatically closes.

2. In the Monitor application transport (or Dolby RMU web client transport), click (highlight) **LTC** to set the RMU to chase timecode from Pro Tools (or the master bus).

3. Verify that Pro Tools (or the master bus) is generating timecode.


   For example, in Pro Tools, place the cursor in the timeline prior to where you intend to punch in, and then start playback.

### Note:
If you are recording to an existing print master, you can start from anywhere in the timeline as long you do not punch in before or after the print-master start and end times.

5. In the Monitor application, punch in and out of recording.

   a. Click (highlight) **O** to punch in and begin recording.

   The first punch-in determines the beginning of the file. You cannot subsequently punch in before the first punch.

   b. When done recording, click (unhighlight) **O** to punch out of recording.

   c. Continue to click (highlight) **O** to punch in, and then again to punch out, as needed.

### Note:
You can also begin recording by first clicking **O** to ready the RMU for recording a print master. Next, make a selection in Pro Tools, and then press **Play** in Pro Tools to start playback and recording. This is useful when updating a specific clip or section in the timeline.

6. When the material has completed, stop playback in Pro Tools.

### 4.7.4 Playing Back a Print Master

You can play back (or monitor playback of) a Dolby Atmos print master, as rendered in the Dolby Atmos format, or re-rendered to a surround format (such as 7.1 or 5.1 channels).

Print-master management is performed via the Dolby RMU web client. The print master selected in a Dolby Atmos project is the print master that will be played back, as long as it has media. For information on projects, and managing print masters in a project, see the manual for your Dolby Rendering and Mastering Unit.

To play back a Dolby Atmos print master:

1. In the Dolby Atmos web client, make active a print master that has media:

   a. Click the **media** button.
b. Click the **print masters** tab to display the list of project print masters.

c. In the **project print masters and .mxfs** dialog, select (highlight) a print master that has media.

A print master that has media displays a media icon in the second column.

**Note:** See the manual for your Dolby Rendering and Mastering Unit for information on adding print masters to the print-master list in the Dolby Atmos web client.

d. Click the **set print master / .mxf** button.

The dialog automatically closes.

2. In the Monitor application, begin playback:

   - To trigger playback via an LTC source (such as Pro Tools), click (highlight) **LTC** to enable chasing to the sync master. The RMU is now ready to chase LTC. Trigger playback from the LTC source.

   - To play back with the Monitor application as the master, makes sure the Monitor **LTC** button is off (unlit), and then click (highlight) > to begin playback. When done, click [x] to stop playback.

### Changing the Timecode Location for Print-Master Playback

Before playing back a print master with the Monitor application as the master, you can set where print-master playback starts by changing the timecode value in the **Time** section.

To change the timecode (location) for print-master playback:

1. Click in the **Time** section display.

   The full timecode location is selected (highlighted).

2. If you want to change only some of the timecode values, click in the display and drag with a mouse to select (highlight) the time scale values you want to change.

3. Modify the values by doing one of the following:

   - Type in new values, and then press <Enter>.

   - Use the right-click commands to modify the values. (For example, to paste in a new value, right-click on the time and choose **Paste**.)

For more information, see *Timecode Right-Click Commands*.

## 4.8 Monitoring with the Dolby Atmos Monitor Application

The Monitor application provides a general set of meters, displays, and controls for all operation modes. These allow for monitoring and working with the following:

- **Communication status**
- **Objects**
- **RMU output meters**
- **Room configuration and speakers**
Additionally, you can select from different view options. See Selecting a Monitor Application View.

To ensure that you hear Dolby Atmos audio from the Dolby RMU outputs, see Hearing Dolby Atmos Audio.

### 4.8.1 Considerations for Hearing Dolby Atmos Audio

Bed and object audio from Pro Tools are routed to the Dolby RMU inputs, and are then routed to the RMU outputs.

To hear bed and object audio, keep in mind the following:

- Bed tracks route to channel outputs that are mapped to the MADI I/O, as configured in I/O Setup, and then route to the Dolby RMU for rendering. Monitor bed audio from the Dolby RMU. Bed audio material outputs from the first ten channel outputs of the Dolby RMU.
- Object tracks route to channel outputs that are mapped to MADI I/O, as configured in I/O Setup. To hear audio from the Dolby RMU output, the object track in Pro Tools must have a Panner plug-in with an object number assignment.
- The Monitor application must be communicating with the Dolby RMU renderer (via a host name or IP address) and have a valid room configuration loaded.
- In the Monitor application, the following controls affect audio presence or level:
  - The linear timecode (LTC) button in the transport: This button must be disabled (unlit) for Pro Tools to output audio to the Dolby RMU, for live monitoring.
  - The mute button in the transport: This button must be disabled for audio to be present at the RMU.
  - Muted speakers in the room configuration: Any speaker that is muted results in no audio from that speaker. If all active speakers are muted, no sound will be heard from the Dolby RMU.
  - The DIM button in the transport: When enabled, this button lowers the volume of signal at the Dolby RMU output by $-20$ dB. Low level content may be inaudible.
  - The output attenuation (ATTEN) control in the transport: When this control is set to $-\infty$ (negative infinity), audio is effectively muted. The attenuator is not displayed by default. If it is not displayed, press `<Control>+<Option>+<Command>+<A>` to display the control and verify it is not set to $-\infty$.
- In the Dolby RMU web client, the following controls affect audio presence or level:
  - The MUTE button at the top of the web client: This button must be disabled for audio to be present at the RMU.
  - The global gain (dB) control in the settings screen: When this control is set to $-60$ dB, audio is effectively muted.
  - The DIM button at the top of the web client: When enabled, this button lowers the volume of signal at the Dolby RMU output by $-20$ dB. Low level content may be inaudible.
4.8.2 Selecting a Monitor Application View

The Monitor application allows for viewing all meters, displays, and controls, meters only, or objects only.

Select a view option, based on your display needs:

- Select **View > All** to view all monitor meters, displays, and controls.

![Figure 4-10  All View in the Monitor Application](image)
• Select **View > Meters** to view meters only.

Meters view displays the object stream, RMU audio output, and room configuration. In this view, the objects view is effectively hidden.

![Figure 4-11 Meters View in the Monitor Application](image)
• Select **View > Objects** to view objects only.

In this view, the objects view occupies the entire display area.

![Figure 4-12 Objects View Only in the Monitor Application](image)

### 4.8.3 Monitoring Objects

The Monitor application includes two sections for monitoring and working with objects:

- **Object Stream**
- **Objects View**

The Monitor application also provides controls for:

- Rendering objects only. See [Monitoring Object Audio Only](#).
Viewing the Object Stream

The object stream in the Monitor application provides a simple display of objects being rendered in the Dolby Atmos session, including their current input status during live monitoring, print mastering, or playback of a print master.

- Yellow Fill = Audio Signal
- Olive Fill = No Audio Signal
- Green Ring = Active Object
- Black Ring = Inactive Object

Figure 4-13 Object Stream Circles and Stream Information

To view the object stream in the Monitor:
- Select View > All or View > Meters.

Identifying the Object Number of an Object

Each object in the object stream has a dedicated object number.

To identify the object number of an object in the object stream:
- With a mouse, hover over the object circle.

Objects in the Object Stream

Objects in the object stream are represented by circles, and stream information is based on color, as follows:

- Yellow fill: The object has audio signal. This status indicates signal presence only. It does not indicate the amount of signal level.
- Olive fill: The object does not have audio signal.
- Green ring around the object circle: The object is active and will be rendered.
- Black ring around the object circle: The object is inactive and not used.

Figure 4-14 Object Stream Circles and Stream Information
Up to 118 objects can be active (in use), as defined as active objects in your panning client (such as Pro Tools) during live monitoring or print mastering.

Note: Always turn on the RMU prior to launching Pro Tools. This will ensure that Pro Tools communication with the RMU has been established.

Displaying Objects View

The objects view in the Monitor application is a virtual auditorium, which provides a visual representation of object positioning and signal level, as rendered by the RMU.

The red outline of the auditorium includes a white rectangle to indicate the front screen, plus transparent left side, right side, and back walls.

![Figure 4-15 Objects View Outline and Front Screen](image)

To display objects view:

- Select View > All or View > Objects.

Modifying Objects View

The objects view in the Monitor application includes controls for changing the visual perspective:

- Normal view: This is the default view of the auditorium, with the front screen at the back of the box, and left side, right side, and back walls in their standard position. From any other view, double-click on the lower part of the objects view to return to normal view.
Rotated and side views: You can rotate the objects view to show side views. Click and drag left or right, and then release.

Figure 4-16  Rotated Display of Objects View

Figure 4-17  Side Display of Objects View
- Overhead view: To display the overhead view of objects, double-click on the upper part of the objects view. To return to normal view, double-click the objects view again.

![Overhead Display of Objects View](image)

**Figure 4-18 Overhead Display of Objects View**

**Objects in Objects View**

The objects view provides monitoring information for each active object:

- Yellow fill: The object has a signal level. The signal level of each object is indicated from bright yellow (louder signals) to low-intensity yellow (softer signals). The threshold is –120 dB.

![Objects View, Yellow and Transparent Fills Shown](image)

**Figure 4-19 Objects View, Yellow and Transparent Fills Shown**

- Transparent fill: The object has no signal level, or another object is being touched for automation.
• Blue fill: The object is currently touched for automation. When an object is touched, all other objects will display as transparent (regardless of whether they have signal).

![Objects View, Blue Object](image)

**Figure 4-20** Objects View, Blue Object

### 4.8.4 Monitoring RMU Outputs

The RMU output meters provide metering for the full RMU output (beds and objects) in the current rendering mode. Object levels are affected by their placement in the room, as defined by Dolby Atmos metadata.
When rendering to the Dolby Atmos format, there are ten meters: L, C, R, Ls, Rs, Lsr, Rsr, Lts, Rts, and LFE. They represent the 9.1 render of the Dolby Atmos mix and how much energy is getting sent to the different zones of the room.

Figure 4-21  Rendering to Dolby Atmos Format, Ten Meters Shown
When re-rendering to another mode (such as 7.1 or 5.1 channels), the number and layout of meters are based on the surround format. For example, Dolby Surround 7.1 has eight meters: L, C, R, Ls, Rs, Lsr, Rsr, and LFE.

**Figure 4-22**  Rendering to 7.1 Channels, Eight Meters Shown
When re-rendering in 5.1 and 7.1, Monitor application meters use a lower clip threshold (~3 dB) to replicate playback in a traditional room where the sound arrays are calibrated to 82 dB.

The RMU includes a +3 dB boost to signal in the surrounds (Ls and Rs in 5.1; Lss, Rss, Lb, and Rb in 7.1) prior to clipping and metering, and then a cut of ~3 dB after that, but before the audio output. This results in the output clipping at a 3 dB lower threshold, and the metering showing a 3 dB higher signal. This also results in the same audio level output from the RMU to support playback in a room with the surrounds calibrated to 85 dB.

The Monitor application also provides controls for:

- Dimming audio with ~20 dB of attenuation. See Dimming RMU Audio Output.
- Manually adjusting the volume. See Changing the Gain of RMU Audio Output.
- Muting one or more speakers. See Muting RMU Output.
- Muting bed output (using Objects Only mode). See Monitoring Object Audio Only.
- Clearing clips.
4.8.5 Monitoring the Room Configuration and Speakers

The room configuration in the Monitor application provides a visual representation of RMU output to speakers, as configured for the target Dolby Atmos room, plus basic monitoring controls for muting.

![Room Configuration](image)

**Figure 4-24** Room Configuration in the Monitor Application Main Window

To view the room configuration:

- Select **View > All** or **View > Meters**.

The room configuration and other data are in a `.dac` zip file on the RMU. When first enabling communication with the RMU, the Monitor application will briefly display a **Waiting for Room Configuration** message. When communication is fully enabled, the message will be replaced with the speakers for the room configuration.

If the file is not present on the RMU (or the Monitor application is not communicating with the RMU), the Monitor application continues to display a **Waiting for Room Configuration** message.

For information on creating and loading a `.dac` file, refer to the manual for your Dolby Rendering and Mastering Unit.
Room Configuration Display

The room configuration provides the following feedback:

- **Yellow fill:** Signal level to the speaker is indicated from bright yellow (louder signals) to low-intensity yellow (softer signals). The signal presence indicators use a range of –80 to –10 dB.
- **Olive fill:** The speaker does not have audio signal.
- **Red ring around the speaker dot:** Output to the speaker is clipping.
- **Mute icon (over a speaker dot):** Output to the speaker is muted.
- **Waiting for Room Configuration:** This message appears for a short time when first establishing communication with an RMU. If the .dac file that contains the room configuration data is not found on the RMU (or the Monitor application is not communicating with the RMU), the message will remain onscreen.

![Room Configuration Indicators](image)

**Figure 4-25  Room Configuration Indicators**

The room configuration also provides controls for:

- **Muting one or more speakers.** See [Muting RMU Audio Output](#).

### 4.8.6 Dimming RMU Audio Output

Use the **DIM** button to lower the volume of signal at the Dolby RMU output. The **DIM** button provides ~20 dB of attenuation.

![Successful Connection Between Monitor and RMU Host Name](image)

**Figure 4-26  Successful Connection Between Monitor and RMU Host Name**
To change the volume with the **DIM** button, do one of the following:

- Click (highlight) the **DIM** button to dim the volume.
- Click (unhighlight) the **DIM** button to undim the volume.

### 4.8.7 Changing the Gain of RMU Audio Output

The output attenuation (**ATTEN**) control provides gain control for RMU output. The attenuation range is 0 to –Infinity dB. When set to –Infinity, audio is effectively muted. The control is hidden by default and requires a keyboard shortcut to display (<Control>+<Option>+<Command>+<A>).

To change the output attenuation:

1. Press <Control>+<Option>+<Command>+<A> to display the control.
2. Rotate the control with a mouse.

### 4.8.8 Muting RMU Audio Output

The Monitor application allows for muting individual speakers or groups of speakers in the room configuration, or all RMU output.

To mute (or unmute) audio with the Monitor application, do the following:

- To mute (and unmute) individual room speakers, click on a speaker icon in the room configuration.
- To toggle the mute status of multiple speakers, select (outline) a group of speakers using a mouse and release. Speakers that were on will mute. Speakers that were muted will unmute.
- To mute (and unmute) all RMU output, click the **MUTE** button in the **Outputs** section. When all output is muted, the **MUTE** button is red and displays **UNMUTE**.

**Note:** The **MUTE** button has no function when a Monitor dialog (such as the **Dolby Atmos Preferences** dialog) is open.

- To mute bed audio, enable **Objects Only mode**.

### 4.8.9 Monitoring Object Audio Only (Objects Only Mode)

During any Monitor mode (live, print master, or playback), you can set monitoring to Objects Only mode. This sets the RMU to render objects only and effectively mute audio from all beds.

**Note:** Objects Only mode is typically used for demonstrations to illustrate what audio is encapsulated in an object and what audio is static in a bed.
To listen to objects only:

1. Launch the **Select Rendering Mode** dialog to reveal rendering selections by doing one of the following:
   - Click in the **Mode** section of the Monitor application window.
   - Click **Dolby Atmos Monitor > Preferences** (Mac) or **Tools > Preferences** (Windows), and then click **Edit** in the **Mode** section.

2. In the **Select Rendering Mode** dialog, click the desired rendering mode, if needed.

3. Click **Objects Only Mode**, and click **Select**.

The Monitor shows that Objects Only mode is enabled by displaying **Objects** in the **Mode** section of the Monitor application window.

![Objects Only Mode](image)

**Figure 4-27** Objects Only Mode

### 4.8.10 Clearing Clips in the RMU Output Meters

The RMU output meters let you clear any clips that are displayed in its meters.

To clear clips in all meters:

- Click in the red clip area of any meter.
4.9 Monitor Application Keyboard Shortcuts Reference

The Monitor application provides shortcuts when it is in focus.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Command&gt;+&lt;F&gt;</td>
<td>Full screen</td>
</tr>
<tr>
<td>&lt;Command&gt;+&lt;H&gt;</td>
<td>Hide the Monitor application</td>
</tr>
<tr>
<td>&lt;Command&gt;+&lt;Comma&gt; (&quot;,&quot; )</td>
<td>Open preferences</td>
</tr>
<tr>
<td>&lt;Command&gt;+&lt;R&gt;</td>
<td>Toggle record print master</td>
</tr>
<tr>
<td>&lt;Command&gt;+&lt;J&gt;</td>
<td>Toggle enable LTC</td>
</tr>
<tr>
<td>&lt;Control&gt;+&lt;Option&gt;+&lt;Command&gt;+&lt;A&gt;</td>
<td>Reveal the gain attenuator control</td>
</tr>
<tr>
<td>&lt;D&gt;</td>
<td>Toggle rendering mode</td>
</tr>
</tbody>
</table>

4.10 Monitor Application Controls and Displays Overview

The Monitor application window has six main sections:

- **Header**, which includes additional sections:
  - **Renderer**
  - **Mode**
  - **Time**
  - **Transport**
  - **Outputs**
  - **View**
- **Object stream**
- **Room configuration and speakers**
- **RMU output meters**
- **Object view**
4.10.1 Monitor Application Window Header

The header in the Monitor application window contains displays for checking the status of your session, and contains transport controls to record a print master or play it back. Additionally, you can re-render to a surround platform during live monitoring or playback.

![Monitor Application Window Header](image)

**Renderer**

The **Renderer** section in the Monitor contains the following:

- IP address or host name
- Connection status

When communication with the RMU is successful, the **Renderer** section provides two indications. The renderer IP or host name will appear in the **Renderer** section, and the connection status light will turn green.

![Successful Connection Between Monitor and RMU](image)

This section also allows for setting the host name or IP address. You can click in the **Renderer** section to open the **Enter Hostname** dialog, and then enter the host name or IP address. (To browse for an address, use the Monitor preferences.)

If the connection status light is red, the connection was unsuccessful. In this case, verify the IP address or host name, check your Ethernet connections, and repeat the steps for enabling communication with the RMU.

**Mode**

The **Mode** section displays the current rendering mode and allows for changing it. Clicking in the **Mode** section opens the **Select Rendering Mode** dialog, which is used to set the mode. You can also press <D> on the keyboard to toggle between the modes.
Rendering mode refers to the format that the RMU uses as it renders, or plays audio beds and objects while positioning them to, or across, up to 64 speakers. Positioning for beds is based on multichannel mixes. Positioning for objects is based on Dolby Atmos metadata.

- During monitoring, the RMU renders audio and metadata from Pro Tools and any client applications (such as the System 5 Panner).
- During print mastering, the RMU renders audio and metadata from Pro Tools.
- During playback, the RMU renders material from the print master (located on the RMU).

Dolby Atmos is the default setting. Additional platforms (such as 7.1 and 5.1 channels) are available.

---

**Note:** The setting of the rendering mode in the Monitor does not affect the print master recording. The rendering mode affects only what is being listened to during recording. A print master created with the Monitor is always a Dolby Atmos print master.

---

**Time**

The **Time** section displays the running time of the RMU during print-master recording and playback of a print master. You can locate to a specific timecode location by double-clicking on the display and typing the timecode location in when playing back from the RMU and not synced to picture. The display includes right-click commands for modifying the timecode location for print-master playback.

The time scale is in hours:minutes:seconds.

During print mastering, you should enable LTC in the Monitor application so that the RMU chases timecode from Pro Tools (or the master bus). The Monitor application will display the sync time (including any offset) as defined for the Pro Tools session. The running time of the print-master recording pass is saved with the print master.

During playback of a print master, you should enable LTC so that the RMU syncs to the house master. The Monitor application will display the same sync time that was displayed during print mastering.

---

**Note:** During Live mode monitoring, you should set the Monitor application **LTC** button to off, to ensure that you are receiving live audio from the Pro Tools session.

---

**Timecode Right-Click Commands**

The **Time** section display includes right-click commands for modifying the timecode location for print-master playback:

- **Cut:** Cuts the highlighted time values after copying them for use with the paste command
- **Copy:** Copies the highlighted time values
• **Paste:** Pastes the last copied or cut values over the highlighted values or at selected location
• **Delete:** Deletes the highlighted time values
• **Select All:** Selects (highlights) all of the values in the display for use with cut, copy, paste, or delete
• **Undo:** Performs an undo operation on the previous cut, copy, paste, or delete
• **Redo:** Performs a redo operation on the previous cut, copy, paste, or delete

### Transport

The Monitor application provides transport buttons in the **Transport** section, which can be used for recording a print master and playing it back:

- **Chase LTC:** LTC
- **Stop:** [X]
- **Play:** >
- **Record arm:** O

Transport buttons support the following print-master tasks:

- Start print mastering: Press LTC, start the LTC source, and then press O.
- Punch in and out of print mastering: Press LTC, start the LTC source, press O to punch in, and then press O to punch out.
- Start playback of a print master by doing one of the following:
  - To trigger playback via an LTC source (such as Pro Tools), press (enable) LTC, start the LTC source, and then press >.
  - To play back with the RMU as master (LTC disabled): Press >.
- Stop playback of a print master (with LTC disabled): Press [X].
- Pro Tools live monitor: No transport controls engaged.

**Note:** The **Transport** section has no function when a Monitor dialog (such as the **Dolby Atmos Preferences** dialog) is open

### Outputs

The **Outputs** section in the Monitor application window provides a **MUTE** button and an attenuator for controlling RMU output.

### Mute Button

The **MUTE** button lets you mute (or unmute) RMU output. The button is displayed in all Monitor application views. See **Muting RMU Audio Output**.
Dim Button

Use the DIM button to lower the volume of signal at the Dolby RMU output. The DIM button provides −20 dB of attenuation. See Dimming RMU Audio Output.

Output Attenuation Control

The output attenuation (ATTEN) control provides gain control for RMU output. The attenuation range is 0.00 dB to −Inf. When set to −Inf (−Infinity), audio is effectively muted. The control is hidden by default and requires a keyboard shortcut to display. See Changing the Gain of RMU Audio Output.

View

The View section in the Monitor application window provides a drop-down menu to set the current Monitor display:

- **All**: Displays all meters, displays, and controls.
- **Meters**: Displays object stream, RMU audio output, and room configuration only. In this view, the object view is effectively hidden.
- **Objects**: Displays object view only.
4.10.2 Signal Generator

Use the pink-noise generator in the Monitor application to validate the C-weighted SPL of each speaker feed and array.

![Generating Pink Noise to a Speaker (Speaker Icon with a Box)](image)

Refer to the manual for your Dolby Rendering and Mastering Unit for instructions on how to test each speaker and speaker array.

The signal generator button is not displayed when the Panner plug-in is in Recorder mode.

**Generating Pink Noise to a Speaker**

To generate pink noise to a speaker:

1. Click on the signal generator button.
2. <Option>-click (highlight) the speaker icon in the room configuration.

![Image of speaker icon]

**Figure 4-31** Generating Pink Noise to a Speaker (Speaker Icon with a Box)

**Generating Pink Noise to a Speaker Array**

To generate pink noise to a speaker array:

1. Click on the **signal generator** button.
2. Select the array from the **speaker array** drop-down menu in the signal generator screen.

![Generating Pink Noise to the Rss Speaker Array](image)

**Figure 4-32** Generating Pink Noise to the Rss Speaker Array
Using the Panner Plug-in to Position Objects

The Dolby Atmos® Panner is an AAX native plug-in (64-bit and 32-bit) for Pro Tools® that defines Dolby Atmos metadata (pan position and other metadata) for a Dolby Atmos mix. The Panner supports 44.1, 48, 88.2, 96, 176.4, and 192 kHz sample rates, and works with mono and multichannel (stereo) track formats.

The Dolby Atmos authoring tools installer includes a 64-bit version of the Panner plug-in and a 32-bit version. The 64-bit Panner is required for Dolby Atmos systems with Avid Pro Tools 11.2.1 running on Mac OS X 10.9.4 (Mavericks). The 32-bit version of the Panner is included for Pro Tools 10.3.9 systems running on Mac OS X 10.8.5 (Mountain Lion). For full requirements, refer to your Dolby Content Services representative.
In a typical Dolby Atmos setup, Dolby Atmos metadata is applied to audio at the RMU and you use the Dolby Atmos Monitor application to listen to the effect of metadata in real time. In this case, metadata in the automation playlist does not affect the sound within the Pro Tools session.

The Panner allows for panning audio objects through all three dimensions of a virtual room in the user interface (UI): left/right (x-axis), front/back (y-axis), and top/bottom (z-axis). You can move objects with a joystick, control surface, mouse, or enabled automation (for example, in Pro Tools).

In the Panner default mode, you pan an object to a point in the room, or from one point in the room to any other point.

**Note:** Pro Tools sessions being monitored or print mastered by a Dolby® RMU must be 48 kHz. If working with different sample rates during sound creation or premixing, change the session sample rate prior to working with the RMU.

For installation information, see [Installing the Dolby Atmos Authoring Tools](#).
5.1 General Use of the Panner in Pro Tools

Most standard Pro Tools plug-in and automation controls are available for the Panner plug-in.

Exceptions include:

- Settings for configuration options are not saved with Panner plug-in presets.

Refer to Pro Tools documentation for additional information on working with plug-ins, including:

- Inserting plug-ins on tracks
- Plug-in window controls
- Automating plug-ins

5.2 Special Considerations when Using the Panner

When using the Panner in Pro Tools, consider the following:

- Pro Tools sessions being monitored or print mastered by a Dolby RMU must be 48 kHz. If working with different sample rates during sound creation or premixing, change the session sample rate prior to working with the RMU.
- Object tracks can be mono or stereo:
  - Mono object tracks use one mono Panner plug-in and provide metadata for their respective mono output channel.
  - Stereo object tracks use one stereo Panner plug-in and provide metadata for their respective stereo output channels (two mono subpaths).
- Only one plug-in mono path or subpath at a time can have a given object number. Up to 118 track voices (at 48 kHz) can be dedicated as objects by inserting a Panner plug-in on their track and selecting a unique object number for each mono path or subpath. The object number represents the output stream the metadata uses. Additional track voices cannot be used as objects, because the Panner plug-in cannot be assigned to an object number greater than 118 or to an object number already in use. You can autoassign object numbers by inserting Panner plug-ins on multiple tracks (all, or all selected), or you must manually assign object numbers after inserting Panner plug-ins individually.

5.3 Panner Plug-in Window Controls and Displays

The Panner plug-in window includes controls and displays to support automating Dolby Atmos metadata for objects in Pro Tools:

- Virtual room
- Object number box
- Operation mode buttons and Zones selector
- X/Y/Z sliders and position displays
5.3.1 Panner Virtual Room

The Panner provides a virtual room in its UI that is used when inputting panning position for an object, or monitoring the object position during automation playback in Pro Tools.

**Figure 5-2  Panner Virtual Room Elements**

The virtual room includes:

- **Room outline:** A bluish outline represents the walls of the room. The top of the virtual room represents the front of the real room (where the screen and L, C, and R zones are located), and the bottom represents the back. Left and right sides represent room left and right, respectively.
- **Zone and overhead indicators:** Zone (or speaker zone) indicators and overhead (Elevation mode) indicators display which speaker zones are active for an object in Dolby Atmos as the RMU interprets metadata from the Panner plug-in. Inversely, this feature is sometimes described as zone exclusion. Zones are also used when the RMU re-renders the Dolby Atmos mix to a surround format (such as 7.1 or 5.1 channels). You can use zones to isolate (or dedicate) an object to a specific speaker or

- **Object Size slider and level display**
- **Configuration options button**
- **Linking selector (stereo plug-in only)**
group of speakers. Zones are displayed as small blue squares in their relative position. Zones on the room outline represent the L, R, C, sides, and rear speaker zones. Six zone configurations are available. Zones are active (teal) or inactive (gray), based on the zones button setting. Additionally, two inner blue squares, located on the x-axis, represent the overheads. They are active (teal) when Elevation mode or an Elevation Snap mode is on; and inactive (gray) when Elevation mode or an Elevation Snap mode is off.

- Pan location cursor: The pan location cursor provides the current position of the object in the room. You can move the cursor with a joystick, control surface, mouse, or enabled automation. The pan location cursor is represented by a yellow dot (located by default at the center of the virtual room). Depending on the Elevation mode and positioning in the room, the cursor changes size: the cursor is larger when the object is more elevated, and smaller when the object is less elevated. As the cursor is moved, the X, Y, and Z sliders and position display values update accordingly. Inversely, the cursor moves when the X, Y, and Z sliders or position display values are adjusted. In Recorder Mode, the cursor is red.

- Object size outline: The outline around the object displays the current spread of its audio in the room. You can set the object size (level of spread) with the Dolby Atmos Panner plug-in UI, or a control surface, mouse, or enabled automation. The outline changes size and direction based on the object size setting and the object position and active speakers in the room.

The color of the area outside of the virtual room indicates the plug-in focus state. Blue indicates the plug-in window (or channel in a stereo plug-in) is focused; gray indicates it is not. The focused plug-in channel is the one controlled by the joystick. For information on configuring a joystick, see Using a Joystick.

Panner plug-ins automatically focus when you:

- Open a plug-in window and touch a control (below the plug-in header).
- Open a plug-in window, and click in the plug-in window (below the plug-in header).

Note: Panner plug-ins lose focus when you touch another window or dialog, including a Pro Tools control outside of the plug-in (such as setting an Automation mode). To resume use of Panner plug-in controls, refocus the plug-in.

5.3.2 Object Number Box

The object number box displays the assigned object number. The Dolby RMU uses this number to identify the object, and in turn, send its audio to the RMU outputs and render its metadata.

Stereo tracks have two object number boxes, one for each mono subpath.
None (or no object number assignment) is represented by a dash (–). By default, no object number is assigned.

You can manually assign object numbers in the plug-in window, or autoassign object numbers when inserting plug-ins with Pro Tools all, or all selected shortcuts.

5.3.3 Operation Mode Buttons and Zones Selector

The Panner plug-in window includes buttons and selectors for enabling or selecting common operation modes and displaying their status.

- **Elevation mode button**: This button toggles Elevation mode on and off. Elevation mode allows for manual adjustment of the z (top/bottom) dimension in the virtual room. When Elevation mode is off, you cannot adjust the z coordinate, but previously written manual adjustments can be read.

- **Elevation Snap mode buttons**: These buttons let you toggle an Elevation Snap mode on or off, in order to change the shape of the ceiling in the room, and in turn, how elevation drops as objects are panned away from the ceiling.

- **Speaker Snap mode button**: This button toggles Speaker Snap mode on and off. Speaker Snap mode moves object audio to the active speaker nearest its established location during playback (for example, to eliminate phantom panning). At the RMU, this ensures that 100% of the audio signal is routed to the single speaker that is nearest to the current spatial placement. Speaker Snap mode does not move the pan location cursor in the virtual room.
- **Zones selector**: This selector lets you select one of six common speaker zone layouts, in order to activate or deactivate specific speaker zones (for example, to isolate or dedicate an object to a specific group of speakers).

### 5.3.4 X/Y/Z Sliders and Position Displays

The X, Y, and Z sliders allow for using a mouse to adjust the location of the object in all three dimensions: x (left/right), y (front/back), and z (top/bottom). You can also use a joystick, control surface, enabled automation, or keyboard to adjust the location. As the X, Y, and Z sliders or position display values are adjusted, the pan location cursor in the virtual room moves accordingly. Inversely, the X, Y, and Z sliders and position display values update when the cursor is adjusted.

You can place or pan an object from any location in the Panner virtual room to any other location. The X and Y sliders have a range of –100 to 100. The Z slider range is 0 to 100.

When Elevation mode is off (elevation button not highlighted), you can adjust x and y coordinates, but you cannot adjust the z coordinate. When Elevation mode is on, you can also adjust the z dimension. In Ceiling and Wedge Elevation Snap modes, the z coordinate is generated from the y coordinate only, and changes as the y coordinate is changed. In Sphere Elevation Snap mode, the z coordinate is generated from x and y coordinates, and changes as they are changed.

Respective x, y, and z position displays provide the value (or coordinates) of the current object position in the virtual room, whether moving the pan location with a joystick, control surface, mouse, enabled automation, or keyboard entry.

**Note:** If the X, Y, and Z sliders and their position displays are not visible at the bottom of the plug-in window, click the Done button in the Configuration Options section to close the options and reveal the sliders and their values.

To change object location, do one of the following:

- Click the slider button and drag to the desired coordinate.
- Click in the slider range to jump to a new coordinate.
- Type a valid value in a slider position display, and press <Enter>. 
Elevation and Z Coordinate User-Interface Elements

In all cases, the Z slider position, its display value, and the z automation playlist match as expected. They always represent the overhead level that is displayed in both the plug-in UI, and the Monitor application. However, there are situations where the rendered audio output may not match the z position being displayed. For example, if you disable Elevation mode after writing z automation, audio will play back rendered without overheads, but the plug-in UI will continue to display the z automation.

There are also situations where the z automation UI and rendered audio output do not update during a write automation pass as expected. If you enable an Elevation Snap mode during a write automation pass, the z automation and elevation amount will not update until new automation data for the corresponding slider is written. For example, when you enable Sphere Elevation Snap mode, updates occur after new x or y automation data is written.

Note: After authoring a Panner plug-in with Elevation mode or an Elevation Snap mode on, you can edit the z automation data that was recorded by using a pencil tool in the z automation playlist. The elevation defined by the new automation will be applied to the rendered object audio in the subsequent playback as long as Elevation mode is enabled.

5.3.5 Object Size Slider and Level Display

The object Size slider lets you spread audio for an object across the room, based on the current object position and active speakers in the room. You can use a joystick, control surface, mouse, enabled automation, or keyboard to adjust the size (or spread). The object size outline, which surrounds the object cursor in the virtual room, shows the current spread for an object. The object size has a range of 0 to 100.

Use object size to increase or decrease the number of loudspeakers used to render a particular object. When rendering in Dolby Atmos, decorrelation is automatically applied across loudspeaker feeds. This increases the perceived image size and impression of envelopment and ambience.

Object size spreads the audio for an object, as follows:

- At 0, object size is effectively off, and audio routes to speakers based on the x/y/z position or Speaker Snap mode.
- At 100, audio spreads to all active speakers, regardless of the location of the cursor.
- For values between 0 and 100, spreading is based on the object size, the object location, and the number of active speakers.

Note: Object size is disabled when Speaker Snap mode is on.
**Note:** When using values between 50 and 100, audio may spread to all active speakers, regardless of the location of the cursor. For example, if you have an object in the center of the room, with size = 51, it is effectively the same as an object in the corner of the room with size = 100. Play with the object size control starting from different room locations to see how object size spreads audio.

![Figure 5-4](image)  
**Figure 5-4**  Increasing Object Size from the Room Center.
The object size level display provides the value of the current object size in the virtual room, whether setting the size with a joystick, control surface, mouse, enabled automation, or keyboard entry.

**Note:** If the object **Size** slider and level display are not visible at the bottom of the plug-in window, click the **Done** button in the **Configuration Options** section to close the options and reveal the slider and its value.

To change object size, do one of the following:

- Click the slider button and drag to the desired coordinate.
- Click in the slider range to jump to a new coordinate.
- Type a valid value in a slider position display, and press <Enter>.
5.3.6 Configuration Options Button

The configuration options button accesses options for manually assigning an object number and configuring a joystick to control pan positioning.

When finished setting configuration options, click Done to close the options area and reveal the standard X, Y, Z, and Object sliders, their position display values, and the Linking selector (stereo only).

Figure 5-6 Configuration Options Button
**5.3.7 Linking Selector (Stereo Plug-in Only)**

The **Linking** selector setting for stereo Panner plug-ins determines how the controls for the L and R channels relate to each other. You can set linking to off (set to none), or to mirror or copy moves by either channel. For more information, see [Linking Stereo Panner Plug-in Controls](#).

![Linking Selector (Stereo Plug-in Only)](image)

*Figure 5-7* Dolby Atmos Panner Plug-in for a Stereo Track

**5.4 Inserting a Panner Plug-in in Pro Tools**

Insert Panner plug-ins on mono or stereo tracks in Pro Tools that are identified as Dolby Atmos objects.

**Note:** When Pro Tools plug-ins are organized by category, the Panner plug-in is located in the **Sound Field** submenu. When organized by company, it is in the **Dolby Laboratories** submenu.

You can insert Panner plug-ins individually, or on multiple tracks simultaneously (using Pro Tools all, or all selected shortcuts):

- When you insert Panner plug-ins individually on tracks, object numbers are not assigned. This means that the plug-in is disabled until an object number is assigned to it.
• When you insert Panner plug-ins using the Pro Tools all, or all selected shortcuts, you can choose how to autoassign numbers. For example, you can choose to not autoassign object numbers in the new plug-ins, or to autoassign new numbers across new and old plug-ins, or new plug-ins only.

You must assign an object number to a plug-in to enable it. This number is used by the Dolby RMU to identify the object and render its metadata. Stereo plug-ins have two object number assignments, one for each mono subpath.

You can manually assign object numbers in the plug-in window, or autoassign object numbers when inserting plug-ins with Pro Tools all, or all selected shortcuts. Inserting plug-ins across multiple tracks and autoassigning object numbers will save you time and simplify the process of adding Panner plug-ins to your Dolby Atmos sessions.

For consistency and ease of use, you should insert all Panner plug-ins in the same insert position (for example, at the beginning or end of the inserts chain). This also makes it easier to display the knobs on a control surface.

**Note:** Typically, you should align the object number assignment with your track name and the number used to name the channel path or subpath. This will help create a logical and consistent numbering and naming scheme.

For example, insert the first plug-in on a track named **Object 1** (for a mono track) or on a track named **Object 1–2** (for a stereo track). In the Pro Tools I/O Setup, you can map the first object to the first available physical output, HD MADI channel 11 (for a mono track) or HD MADI channel 11 and 12 (for a stereo track).

### 5.4.1 Manually Assigning an Object Number

You can assign an object number manually to a Panner plug-in. This is useful for enabling a single plug-in that currently does not have a number. You can also change an existing object number to another available number, or to None (to disable the Panner). Numbers greater than 118 or in use by another path or subpath will be unavailable.

To assign an object number (or change an existing object number assignment):

1. Open a Panner plug-in window.
2. If configuration options are not displayed above the virtual room in the plug-in window, click the configuration options button.
3. In the **Configuration Options** section, click the **Object ID** selector and select or type an object number. Object numbers 1–118 are provided in the **Object ID** selector by default for selection. Currently used numbers appear in gray and are not available.

![Object ID Selector](image)

**Figure 5-9**  Object ID Selector in a Panner Plug-in

**Note:** Typing a single alphabet key and clicking <Enter> selects None. This is an alternative way to effectively stop the plug-in from sending metadata to the RMU.

4. To close the **Configuration Options** section, click **Done**.

After an assignment has been made (and the **Configuration Options** section has been closed), the assignment will appear in the plug-in object number box. None is represented by a dash (—).
Renderer Connection Status

Besides providing the drop-down menu for assigning an object number, the Object ID section displays the Renderer connection status. This is the communication status between Panner plug-ins in Pro Tools and the Renderer software on the Dolby RMU.

The color of the IP address or host name denotes the status:
- Green: Renderer is connected.
- Red: Renderer is not connected.

5.4.2 Inserting Multiple Plug-ins and Automatically Assigning Object Numbers

You can insert Panner plug-ins across multiple tracks of the same type (or channel width) at one time. Panner plug-ins can be inserted to the same insert position on all tracks, or all selected tracks, using standard Pro Tools all, or all selected shortcuts.

When you insert Panner plug-ins using Pro Tools all, or all selected shortcuts, you can choose how to autoassign numbers across new and existing plug-ins. For example, you can choose to not autoassign object numbers in the new plug-ins, or to autoassign new numbers across new and old plug-ins, or new plug-ins only.
To insert Panner plug-ins to the same insert position in all tracks:
1. <Option>-click a plug-in insert selector, and select the Panner plug-in.
2. In the dialog, choose an autoassign option.

To insert Panner plug-ins to the same insert position in all selected tracks:
1. Choose (highlight) one or more track names.
2. <Option>+<Shift>-click a plug-in selector, and select the Panner plug-in.
3. In the dialog, choose an autoassign option.

**Note:** When working with sessions that have mono and stereo plug-ins, consider placing all plug-ins of the same width together, and then performing autoassignment of the first set, and then the second set, to maintain sequential numbering from the first plug-in to the last.

### Autoassign Options

When inserting Panner plug-ins with Pro Tools all, or all selected shortcuts, the following autoassignment options are provided:

- **None (autoassign object numbers to no plug-ins):** New Panner plug-ins are not assigned object numbers. Existing plug-ins are unaffected and retain their object numbers.

- **Overwrite existing (autoassign object numbers to all plug-ins):** All Panner plug-ins are assigned (or reassigned) the next available object number for a mono object (or the next two available numbers for a stereo object). Assignments are made in track sequential order (left to right, or top to bottom). Existing plug-ins are affected, depending on where they are located in the session.

- **Preserve (autoassign object numbers to new plug-ins only):** Each new Panner plug-in is autoassigned the next available object number for a mono object (or the next two available numbers for a stereo object). Assignments are made in track sequential order (left to right, or top to bottom). Existing plug-ins are unaffected and retain their object numbers.

### 5.5 Controlling the Panner

You can control the Panner with any of the following:

- **Joystick**
- **Control surface**
- **Mouse**
- **Keyboard**
5.5.1 Using a Joystick

When the joystick has been prepared, you can use it to grab the object (pan location cursor) and position it anywhere in the Panner virtual room.

To grab the object (pan location cursor) with the joystick:
1. Open the plug-in window.
2. Click the touch button of a non-touch-sensitive joystick (such as a JLCooper MCS-Panner), or move the joystick (if it is a touch-sensitive joystick).

You can also use the joystick switches and knobs to determine other Panner behaviors. The following table provides functions for a JLCooper MCS-Panner.

<table>
<thead>
<tr>
<th>JLCooper MCS-Panner Switch or Knob</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 and E2</td>
<td>Modify elevation. Turning to the right elevates the object in the audio field; turning to the left lowers the object in the audio field.</td>
</tr>
<tr>
<td>S1</td>
<td>Turn off Elevation mode.</td>
</tr>
<tr>
<td>S2</td>
<td>Turn off Sphere Elevation mode.</td>
</tr>
<tr>
<td>S3</td>
<td>Toggle Wedge Elevation on/off.</td>
</tr>
<tr>
<td>S4</td>
<td>Turn on Sphere Elevation mode.</td>
</tr>
<tr>
<td>S5</td>
<td>Turn off Speaker Snap mode.</td>
</tr>
<tr>
<td>S6</td>
<td>Turn on Speaker Snap mode.</td>
</tr>
</tbody>
</table>

Preparing to Use a Joystick

To prepare a joystick to control a Panner plug-in, complete the following:
1. Installing the joystick
2. Configuring the joystick in a Panner plug-in

Installing a Joystick

Before you can use a joystick to control the Panner, you must install the joystick to a MIDI interface on the computer running Pro Tools for Dolby Atmos.

To install a joystick (such as a JLCooper MCS-Panner) on the Pro Tools computer:
1. Obtain a suitable USB MIDI interface. It must have at least one set of female MIDI in and out connectors.
2. Install the USB MIDI interface on the Pro Tools computer. Refer to the interface documentation for installation and configuration requirements.
3. Configure the joystick in **Audio MIDI Setup**, as follows:
   a. On the Pro Tools computer, navigate to **Audio MIDI Setup** (located at /Applications/Utilities/Audio MIDI Setup).
   b. Double-click the **Audio MIDI Setup** application.
   c. Click **Window > Show MIDI Window**.
   d. Click **Add Device**.
   e. Double-click on the *new external device* icon, and set properties for the device. (For example, give it a device name of *joystick* or something similar.)
   f. Click **Apply**.
   g. On the screen, connect the MIDI out of the joystick device to the MIDI in of the USB MIDI interface.
   h. On the screen, connect the joystick to the USB MIDI interface by clicking the arrow for the joystick output port (and holding the mouse button down), and then dragging an onscreen connection cable to the input arrow of the USB MIDI device.

4. Obtain a suitable joystick. The Dolby Panner plug-in was designed and tested with the JLCooper MCS-Panner. You may substitute other devices.

5. Set the DIP switches on the MCS-Panner. You must set switches 1, 3, and 4 to the on (down) position.

6. Plug the MCS-Panner MIDI in and out cables into the USB MIDI interface MIDI out and in connectors, respectively.

**Configuring a Joystick in a Panner Plug-in**

Before you can use a joystick to control the Panner, you must configure the joystick in a Panner plug-in.

To configure a joystick in a Panner plug-in:

1. Open a Panner plug-in window.
2. If configuration options are not displayed above the virtual room in the plug-in window, click the configuration options button.
3. In the **Object ID** section, verify that there is an object number. If a new object number is needed, **assign a new object number**.
4. In the **Joystick Device** section, use the joystick device input and output selectors to select the joystick as the input and output device.

5. Test the connection by moving the joystick. The yellow dot in the plug-in should move as the joystick is moved.

6. To close the **Configuration Options** section, click **Done**.

7. Repeat the preceding steps, and configure the joystick in each of the remaining Panner plug-ins in the session.

### 5.5.2 Using a Control Surface or Mixing Console

From a control surface or mixing console qualified by Dolby, you can map Panner plug-in controls to physical controls. You can then edit and automate parameters from the control surface or console.

Refer to your control-surface or console documentation for detailed information on how to use it to control standard plug-in features.

You can use the Panner with most control surfaces and mixing consoles that support page tables (such as Avid® D-Command® or D-Control™, or an Artists Series control
Controlling the Panner

surface), including Avid Pro Series control surfaces (such as System 5) in EUCON™ mode. Contact your Dolby Content Services representative for a full list of supported control surfaces and consoles.

With the System 5 Panner application, you can map the panner controls of each Dolby Atmos object in the RMU to a dedicated channel strip on an Avid System 5. See the System 5 Panner Application for Dolby Atmos Manual.

Table 5-2 Panner Support by Control Surfaces and Mixing Consoles

<table>
<thead>
<tr>
<th>Function</th>
<th>Avid D-Command and D-Control</th>
<th>Avid System 5 (with System 5 Panner Application)</th>
</tr>
</thead>
<tbody>
<tr>
<td>x, y, and z position</td>
<td>Encoders, or faders (in Flip mode); or joysticks (x and y position only); or Pro Tools Surround Panner joystick (x and y position, D-Control only); or touchscreen (x and y position, D-Control only)</td>
<td>Channel strip x, y, and z encoders; or joysticks (x and y position only)</td>
</tr>
<tr>
<td>Automatic z-axis panning with Elevation Snap modes</td>
<td>Encoders, faders (in Flip mode), or joysticks; or touchscreen (D-Control only)</td>
<td></td>
</tr>
<tr>
<td>x, y, and z position with stereo Panner plug-in linking</td>
<td>Encoders, faders (in Flip mode), or joysticks; or touchscreen (D-Control only)</td>
<td>Channel-strip x, y, and z encoders; or joysticks (x and y position only)</td>
</tr>
<tr>
<td>Elevation mode</td>
<td>Encoders, or faders (in Flip mode)</td>
<td>Channel strip <strong>Elev On</strong> switch</td>
</tr>
<tr>
<td>Elevation Snap modes (for Sphere Elevation, Wedge Elevation, or Ceiling Elevation)</td>
<td>Encoders, or faders (in Flip mode)</td>
<td>Channel strip <strong>Elev</strong> encoder and Sel switch</td>
</tr>
<tr>
<td>Speaker Snap mode</td>
<td>Encoders, or faders (in Flip mode)</td>
<td>Channel strip <strong>SpSn</strong> encoder, or On switch</td>
</tr>
<tr>
<td>Zones</td>
<td>Encoders, or faders (in Flip mode)</td>
<td>Channel strip <strong>SpZn</strong> encoder and Sel switch</td>
</tr>
<tr>
<td>Focusing a Panner plug-in</td>
<td>Select switches</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>
Using the Panner Plug-in to Position Objects

Note: You can map Panner plug-in controls to D-Command or D-Control encoders, faders, and B/M/P switches (in custom faders and in channel strips only). You cannot map these controls to the EQ or dynamics section of a control surface.

Standard control surface features are supported by the Panner plug-in, including:

- Adding and removing plug-ins
- Focusing (mapping) plug-in controls
- Opening one or more plug-in windows onscreen
- Targeting a plug-in window
- Toggling plug-ins (inactive or active)
- Changing plug-in presets from the channel strips
- Copying and pasting plug-in settings
- Enabling plug-in automation
- Creating plug-in maps with Learn mode

Refer to your control surface or console documentation for detailed information on how to use it to control standard plug-in features.

Panning Objects with the D-Control System Surround Panner Option (Joystick)

On D-Control systems with the Pro Tools Surround Panner option installed, you can use the Surround Panner joystick to pan objects across the x-axis and y-axis. The rotary encoder cannot be used for panning objects.

You must focus the desired channel first, as described in the following steps.

To map the Panner plug-in to the D-Control system Surround Panner option joystick:

1. Click the Target switch on the Surround Panner option.
2. Press the Custom button in the touchscreen.
3. Map the Panner plug-in to a channel strip:
   a. On a channel strip, press the Insert switch.
   b. On the same channel strip, press the Sel (select) switch for the plug-in insert location (such as insert A).
4. Map the X joystick:
   a. In the touchscreen, press Assign X. The Assign X button blinks blue.
   b. On the channel strip, touch the encoder for Pan X on the channel strip.
5. Map the Y joystick:
   a. In the touchscreen, press Assign Y. The Assign Y button blinks blue.
   b. On the channel strip, touch the encoder for Pan Y on the channel strip.

The joystick is ready to use for panning.
5.5.3 Positioning an Object Using a Mouse

You can also use a mouse to position the object (pan location cursor) precisely in the virtual room.

To position the object using a mouse, do one of the following:

• Click and drag the pan location cursor, which represents the object.
• Click and hold on another location in the room to move the object to that location.
• In a slider, click the slider button and drag to the desired coordinate.
• In a slider, click in the slider range to jump to a new coordinate.

5.5.4 Positioning an Object Using a Keyboard

To position an object (pan location cursor) precisely in the virtual room with a keyboard:

• Type a valid value in a slider position display, and press <Enter>.

5.6 Operation Modes

The Panner includes several different modes for use when adjusting and automating panning. You can use many of these modes at the same time.

The following modes are available in the Panner plug-in window, and can be automated in Pro Tools:

• Bypass (Master Bypass) mode
• Default mode (X/Y/Z and Size)
• Elevation mode
• Elevation Snap modes
  • Ceiling Elevation
  • Sphere Elevation
  • Wedge Elevation
• Speaker Snap mode
• Zones

Note: All modes (except for the Elevation Snap modes) are automated in separate automation playlists.

5.6.1 Bypass (Master Bypass) Mode

The bypass switch in the Panner plug-in header effectively stops plug-in metadata from being sent to the Dolby RMU. When the bypass switch is on, metadata no longer routes to the Dolby RMU. However, all audio from the object track continues to output from the Dolby RMU.
You can automate bypass on and off in Pro Tools by using the master bypass automation playlist.

### 5.6.2 Default Mode

In the Panner plug-in default mode, all three dimensions, x (left/right), y (front/back), and z (top/bottom) are separately adjustable with dedicated X, Y, and Z sliders. You can place or pan an object from any location in the Panner virtual room to any other location. Additionally, the object Size slider can be used to spread audio across the dimensions.

By default, Elevation mode is on (elevation button highlighted). This makes active both overhead speakers in the virtual room. Additionally, this allows for adjustment of the z dimension. You can adjust the z dimension only when Elevation mode is on.

The default zones setting is seven, making active seven speaker zones (L, C, R, Lss, Rss, Lsr, and Rsr).

For stereo Panner plug-ins, Linking is set to None by default.

The x, y, and z coordinate positions, object size, Elevation mode status, and active zones, can all be automated in Pro Tools.

### 5.6.3 Using Elevation Mode

Elevation mode allows for manual adjustment of the z (top/bottom) dimension in the Panner virtual room. When on (elevation button highlighted), two overhead zones are made active in the room (and are displayed as two blue squares left and right of the center of the room). Elevation mode is on by default.

Elevation mode forms a flat ceiling across the virtual room. The elevation z coordinate is not linked to x and y coordinates, and is adjusted independently. You can adjust the elevation across the room with a joystick, control surface, mouse, or enabled automation.

To use Elevation mode:

1. Turn on Elevation mode by doing one of the following:
   - Click (highlight) the elevation button.
   - Use a control surface.
2. Adjust elevation (the Z setting) using any of the following:
   - E1 or E2 on a joystick.
   - Control surface.
   - Mouse (with the Z slider).

You can automate elevation mode on and off in Pro Tools by using the Elevation mode automation playlist.
Disabling Elevation Mode

To disable Elevation mode, do one of the following:

- Click (unhighlight) the elevation button.
- Press S1 on the joystick.
- Use a control surface.

5.6.4 Using Elevation Snap Modes

Elevation Snap mode refers to the automation playlist that supports three modes that change the shape of the ceiling in the room, and in turn, how elevation drops as objects are panned away from the ceiling.

- **Ceiling Elevation** gives the room a flat ceiling in the back 80% of the room and a curving ceiling from the front 20% of the room to the screen.
- **Sphere Elevation** gives the room a domed ceiling.
- **Wedge Elevation** gives the room a peaked ceiling.

You can automate Elevation Snap modes in Pro Tools by using the Elevation Snap mode automation playlist. Elevation Snap mode has four states: ceiling elevation, wedge elevation, sphere elevation, and off.

Using Ceiling Elevation

Ceiling elevation links the z elevation to the y coordinate to form a flat ceiling inside the Panner virtual room that curves from the front 20% of the room to the screen. The elevation is constant in the back 80% of the room. Elevation drops uniformly as objects are moved away from the front 20% of the room to the screen. Left or right movements on the x-axis do not change the object elevation.

To use ceiling elevation:

1. Turn on ceiling elevation by doing one of the following:
   - Click the elevation snap selector, and select (highlight) the ceiling elevation icon.
   - Use a control surface.

2. Adjust elevation by moving the y coordinates with any of the following:
   - Joystick.
   - Control surface.
   - Mouse (on the pan location cursor or Y slider).

You can automate ceiling elevation on and off in Pro Tools by using the Elevation Snap mode automation playlist.
Disabling Ceiling Elevation

To disable ceiling elevation mode, do one of the following:
- Click (unhighlight) the ceiling elevation icon.
- Turn on Elevation mode or another Elevation Snap mode.
- Use a control surface.

Sphere Elevation

Sphere elevation links the z elevation to the x and y coordinates to form a hemispheric dome inside the Panner virtual room. The highest point of the dome is the exact center of the room. Elevation decreases uniformly as you move away from the center in any direction. Elevation drops to the bottom at the four points where the hemisphere meets the virtual walls.

To use sphere elevation:
1. Turn on sphere elevation by doing one of the following:
   - Click the elevation snap selector, and select (highlight) the sphere elevation icon.
   - Press S4 on the joystick.
   - Use a control surface.
2. Adjust elevation by moving the x and y coordinates with any of the following:
   - Joystick.
   - Control surface.
   - Mouse (on the pan location cursor or X and Y sliders).

You can automate sphere elevation on and off in Pro Tools by using the Elevation Snap mode automation playlist.

Disabling Sphere Elevation

To disable sphere elevation mode, do one of the following:
- Click (unhighlight) the sphere elevation icon.
- Turn on Elevation mode or another Elevation Snap mode.
- Press S2 on the joystick.
- Use a control surface.

Using Wedge Elevation

Wedge elevation links the z elevation to the y coordinate to form a peaked ceiling inside the Panner virtual room. The highest elevation is a line running left and right at the center of the room. Elevation drops uniformly as objects are moved away from that center line on the y-axis toward either the front or back of the room. Left or right movements on the x-axis do not change the object elevation.
To use wedge elevation:

1. Turn on wedge elevation by doing one of the following:
   - Click the elevation snap selector, and select (highlight) the wedge elevation icon.
   - Press S3 on the joystick.
   - Use a control surface.

2. Adjust elevation by moving the y coordinates with any of the following:
   - Joystick.
   - Control surface.
   - Mouse (on the pan location cursor or Y slider).

You can automate wedge elevation on and off in Pro Tools by using the Elevation Snap mode automation playlist.

**Disabling Wedge Elevation**

To disable Wedge Elevation mode, do one of the following:

- Click (unhighlight) the wedge elevation icon.
- Turn on Elevation mode or another Elevation Snap mode.
- Press S3 on the joystick again.
- Use a control surface.

### 5.6.5 Recording Metadata from the RMU

Use Recorder mode to record object metadata into Panner plug-in automation playlists in Pro Tools, from any of the following sources:

- Metadata sent to the RMU from another Pro Tools system
- Metadata sent to the RMU from another client (such as a System 5 mixing console using the System 5 Panner application, or an AMS Neve DFC console)

Recorder mode is useful for:

- Bringing object metadata from multiple Pro Tools playback machines into a single Pro Tools record machine
- Creating music and effects for a different language version of the film
- Updating previous metadata in the Pro Tools session with new data from real-time mixing console moves (such as from an AMS Neve DFC)

In normal Panner plug-in operation (Recorder mode disabled), each Panner plug-in is the automation master for its respective object. As the automation master, the plug-in provides object position metadata to the RMU, and Panner plug-in controls are available for use.

When Recorder mode is enabled on a Panner plug-in, the pan location cursor is red. Additionally, all Panner plug-in controls (other than Recorder mode) are read only, and are displayed as grayed out or in a lighter tone. In this mode, Panner plug-ins and their
automation playlists no longer send data to the RMU. Instead, they receive data from a valid source (such as a Pro Tools playback machine), which can be recorded to their plug-in automation playlists.

On Dolby Atmos systems using Pro Tools 10, metadata is not recorded to the automation playlist on a track when the track is in input or record mode. This is because automation write modes are disabled in these modes. See Recording Audio and Metadata at the Same Time with Pro Tools 10.

Recorder mode can be enabled for all plug-ins in the session or individual plug-ins.

To record metadata from a valid source (such as a Pro Tools playback machine) to Panner plug-in automation playlists:

1. Confirm system connections and configurations. For example:
   - The Pro Tools destination (or recorder) machine and any additional Pro Tools playback machines or other clients that communicate to the RMU must be connected to the network and configured for use.
   - Pro Tools machines must be synced together. Common solutions include chasing LTC from a timecode generator, slaving to Sony® P2 machine control, or using the Avid Satellite Link option. If working with Avid Satellite Link, consider configuring the Pro Tools recorder machine as the first (administrator) machine, and playback machines as subsequent (nonadministrator) machines.

2. Prepare Panner plug-ins in the destination Pro Tools machine that will record incoming automation metadata, by doing the following:
   - For each Panner plug-in, confirm that all of its Dolby Atmos Panner automation parameters are enabled.
   - For each track with a Panner plug-in, set the Automation mode to one of the modes that write automation (such as Write, Touch, and Latch modes).

3. Enable Recorder mode by the doing the following:
   a. Open any Panner plug-in window.
   b. If configuration options are not displayed above the virtual room in the plug-in window, click the configuration options button.
Figure 5-12  Configuration Options Button in a Panner Plug-in

c. In the Configuration Options section, click the Recorder mode button if you want to enable recording for all Panner plug-ins. If you want to enable recording on individual Panner plug-ins, <Shift>-click the Recorder mode button in the plug-in, and repeat the enable Recorder mode steps for additional plug-ins.
In Recorder mode, the pan location cursor is red.

![Red Cursor in Recorder Mode](image)

**Figure 5-13** Recorder Mode Button in a Panner Plug-in

**Note:** To enable Recorder mode on individual Panner plug-ins, <Shift>-click the Recorder mode button on individual Panner plug-ins.

4. To close configuration options, click the configuration options button.
5. Begin playback.
6. When done recording metadata, stop playback.

**Recording Audio and Metadata at the Same Time with Pro Tools 10**

On Dolby Atmos systems using Pro Tools 10, if you want to record audio to an object track (or monitor input audio on an object track) at the same time you record panner metadata with Recorder mode, you must create two tracks for the object. This is necessary because in Pro Tools 10, automation write modes are disabled when a track is in record or input mode. In this scenario, create an object audio track (for recording and monitoring audio only), and then a panner track (where you insert the Panner plug-in and record automation metadata only).

When working with multiple objects, you can easily create panner tracks from existing object audio tracks by reimporting the object audio tracks as new tracks using the Pro
Tools import session data command. This automatically names the panner tracks with a .1 extension. When tracks are sorted by name, each panner track immediately follows the object audio track. You can then insert Panner plug-ins on the panner tracks.

5.6.6 Using Speaker Snap Mode

Speaker Snap mode moves object audio to the active speaker nearest its established location during playback. At the RMU, this ensures that 100% of the audio signal is routed to the single speaker that is nearest to the current spatial placement. The location of the speaker that the object snaps to is based on the current room configuration (defined by the .dac file, located on the RMU), and can vary from one room to another. Speakers in inactive zones are ignored in Speaker Snap mode.

Speaker Snap does not move the pan location cursor in the virtual room.

Speaker Snap is useful for eliminating phantom panning. For example, in the Panner default mode (Speaker Snap mode off), the algorithm might spread the audio of one object across two or more speakers. Speaker Snap mode prevents this by snapping all of the audio to the single speaker nearest the indicated position of the object in the Panner virtual room.

Note: For a visual representation of which speaker the audio snaps to, look at the room configuration in the Dolby Atmos Monitor application.

When Speaker Snap mode is on, object size is disabled.

To turn Speaker Snap mode on, do one of the following:
- Click (highlight) the speaker snap button.
- Press S6 on the joystick.
- Use a control surface.

You can automate Speaker Snap mode on and off in Pro Tools by using the snap automation playlist.

Disabling Speaker Snap Mode

To turn Speaker Snap mode off, do one of the following:
- Click (unhighlight) the speaker snap button.
- Use a control surface.

5.6.7 Zones

Zones in the Panner plug-in define which speaker or speaker zones (excluding overheads) are active for the object, as the RMU interprets the object metadata. Zones are also used when the RMU re-renders the Dolby Atmos mix to a surround format (such as
Using the Panner Plug-in to Position Objects

7.1 or 5.1 channels). Zones can be useful to isolate (or dedicate) an object to a specific speaker or group of speakers.

Inactive zones are effectively muted for live monitoring or print master recording. Additionally, speakers in inactive zones are ignored in Speaker Snap mode.

Zones are displayed in the virtual room as blue squares in their relative position. Zones on the room outline represent the L, C, R, Lss, Rss, Lsr, and Rsr speakers or speaker zones. Zones are active (teal) or inactive (gray), based on the setting of the zones button.

Zones work in conjunction with Elevation mode and Elevation Snap mode, which activate the overheads for use while panning.

Provided zones include:

- Back only: Enables Lss, Rss, Lsr, and Rsr zones
- Front only: Enables L, C, and R zones
- Three: Enables C, Lsr, and Rsr zones
- Five: Enables L, C, R, Lss, and Rss zones
- Seven: Enables L, C, R, Lss, Rss, Lsr, and Rsr zones

To change the current zone in the Panner, do one of the following:

- Click the zones button in the Panner, and select a zone.
- Use a control surface.

You can automate zones in Pro Tools by using the zones automation playlist.

5.7 Linking Stereo Panner Plug-in Controls

You can insert the stereo Panner plug-in on any stereo track. You can adjust controls on each channel independently (unlinked), or linked to either copy or mirror actions made on the other channel.
To set how stereo panning controls are linked:

- Click the Linking selector, and select None, Mirrored, or Copy.

![Linking Selector in a Stereo Panner Plug-in, Set to Mirrored](image)

**Figure 5-14** Linking Selector in a Stereo Panner Plug-in, Set to Mirrored

**Note:** You cannot automate the Linking setting. To pan material with one option and then switch to another, do separate automation record passes.

Avid D-Command and D-Control work surfaces support using the stereo Panner plug-in linking control to change the x-, y-, or z-axis position of the two objects in a stereo object. See Panner Support by Control Surfaces and Mixing Consoles.

### 5.7.1 Stereo Panner Linking Options

The Linking selector setting in a stereo Panner plug-in determines how the controls for Left and Right channels relate to each other. The options are:

- **None:** The Left and Right channel controls operate completely independently. Actions taken in one channel do not affect the other.
- **Mirrored:** Any action in one channel automatically places its mirror image in the other. For example, panning from center to the left in the Left channel produces a pan from center to right in the Right channel.
• **Copy**: Any action in one channel is copied to the other. For example, panning from the center to the left in the Left channel also produces a pan from center to left in the Right channel.

### 5.8 Automating Panner Controls

You can automate many of the Panner plug-in controls in Pro Tools. The recorded (written) automation for these controls defines the metadata that is sent to the RMU for rendering a Dolby Atmos mix (or for re-rendering to a surround format).

The Panner supports the following automation:

- **Bypass (Master Bypass)**: Bypass status for plug-in metadata (on or off). When set to on, audio from the object track continues to output from the Dolby RMU.
- **Pan X**: Pan location in the x (left/right) dimension, (–100 to 100).
- **Pan Y**: Pan location in the y (front/back) dimension, (–100 to 100).
- **Pan Z**: Pan location in the z (top/bottom) dimension, (0 to 100).
- **Size**: (0 to 100).
- **Elevation**: Elevation status (on or off).
- **Elevation Snap**: Elevation Snap mode states (ceiling elevation, wedge elevation, sphere elevation, or off).
- **Snap**: Speaker Snap mode status (on or off).
- **Zones**: Active speaker zones: back only, front only, three, five back, five, and seven.

To automate metadata for a Panner plug-in:

1. Enable automation for all Dolby Atmos parameters for proper operation.
   Parameters can be enabled by doing one of the following:
   - In the Panner plug-in window, open the **Panner Plug-in Automation** window, and enable automation for all parameters.
   - Open the **Mixing Preferences** dialog, and enable the option for all plug-in controls to default to autoenabled.
   - `<Command>+<Option>+<Control>` the automation button at the top of the plug-in window to enable all options.
2. For the object track that will be automated, click its **Automation Mode** selector, and set the desired automation mode.
3. Start playback, and automate panner controls as desired.
4. When done writing automation, stop playback.
5.9 Resizing the Panner Plug-in Window

You can resize the default plug-in window to improve display.

To resize the Panner plug-in window:

- Drag the lower-right corner of the window to change the size of the window. Drag upwards or to the left to decrease the size of the window, or downward or to the right to increase the size of the window.
- If you want to return to the default window size, do one of the following:
  - Drag the lower right corner fully upward and to the left until the window no longer changes size.
  - Delete the preferences file (com.dolby.panner.aax.plist), located at /Library/Preferences.
This chapter provides examples of Dolby Atmos® workflows.

- Using a Traditional Dolby 7.1 (or 5.1) Mix Audio to Create a Dolby Atmos Mix
- Using Traditional Dolby 7.1 (or 5.1) Mix Audio Channels and Console Automation to Create a Dolby Atmos Mix

6.1 Using Traditional Dolby 7.1 (or 5.1) Mix Audio Files to Create a Dolby Atmos Mix

The following workflow provides one example of how to set up a mix session to remix a Dolby® 7.1 mix to the Dolby Atmos format. It refers to a 7.1 mix that was recorded traditionally with a large-frame console and recorded premixes, as opposed to a mix performed entirely within Pro Tools®. The workflow for remixing a 5.1 mix is the same.

1. Complete the final mix in Dolby 7.1.
2. Confirm Dolby Atmos system setup. For information on installing and connecting the Dolby RMU, see the manual for your Dolby Rendering and Mastering Unit.

3. Create a new Pro Tools session.
4. Configure basic routing in Pro Tools (via Pro Tools I/O Setup). Create separate output paths for beds and objects with the following considerations:

![Basic Dolby Atmos System Block Diagram](image)
- Beds include two output paths, one for the Dolby RMU 7.1 arrays, and the other for the RMU overhead surround arrays. Outputs 1–8 are set up as a single 7.1 output with mono subpaths. The multichannel path is named “Atmos 7.1 Bed.” In Pro Tools, the physical output order is L, R, C, LFE, Lss, Rss, Lsr, Rsr. These outputs address the RMU 7.1 arrays. Outputs 9–10 are set up as a single stereo output with mono subpaths, named “Atmos OH Bed.” These outputs address the RMU overhead surround arrays.

- Outputs 11–118 are object outputs. They are set up as stereo outputs with mono subpaths, so that they can be used on stereo and mono object tracks. They address the RMU object inputs.

---

**Figure 6-2** I/O Setup Output, Configured for Dolby Atmos

5. Prepare effects and Foley premixes for the Dolby Atmos mix by doing the following:
   a. Rerecord all effects, ambience, and Foley premixes and their associated reverbs, applying the final mix console automation as new 7.1 premixes. Printed 7.1 premixes should include leveling and audio processing (such as EQ, dynamics, and LFE).
   b. If necessary, rerecord reverbs that were added during the final mix as a separate premix. For example, this allows for replacing the reverb with a 9.1 reverb in the Dolby Atmos mix.
c. To simplify navigation and file management on a control surface, consider assigning each imported premix a VCA master.

![Image of a control surface with VCA Master Tracks Assigned to Each Effects and Foley Premix](image)

**Figure 6-3** VCA Master Tracks Assigned to Each Effects and Foley Premix

6. Prepare dialogue elements for the Dolby Atmos mix. Consider the type of film (such as an animated feature versus an action feature) when performing the following steps, for example:
   a. Consider creating separate dialogue premixes where no characters overlap by running all dialogue premixes through the console final mix automation and combining them.
   b. Consider printing final mix reverbs as separate elements.

7. Prepare music elements:
   - In Pro Tools, import the music elements using the same process as described for effects and dialogue. For more enhanced Dolby Atmos mixing of the music, it is desirable to get the flattened music separations (such as percussion, strings, synthesizers, and solo instruments) from the final mix music session.
8. For ease of comparison to the 7.1 mix, consider importing the 7.1 print master into the Pro Tools session.
9. In the session, conform to existing reel breaks.
10. Decide which premixes are bed material (9.1 mixes) and which premixes would benefit by being made into objects (mono or stereo) for Dolby Atmos panning.
11. Make sure all beds are assigned to bed outputs.
12. Create object tracks in Pro Tools:
   - Lay out up to 118 objects, with the following suggested considerations:
     a. Lay out objects in groups of eight mono tracks to facilitate moving entire 7.1 premix regions from the prepared premixes.
     b. Further categorize the groups into dialogue, music, mono effects, and stereo effects segments to expedite the creation of stems and music effects masters used for foreign language.
   - Consider creating a mix/edit group for each group of objects, to allow for simultaneous (mono) or individual panning.

![Figure 6-4 Mix/Edit Groups in Pro Tools Groups Window, Active Groups in Gray](image)

- A VCA hierarchy greatly simplifies leveling, and expedites navigation on a control surface. Use VCA master tracks to control each group of objects.
- Additionally, create VCAs for dialogue, music, and effects object VCAs to further
control object VCAs for each segment. In turn, control these VCAs with a single all-objects VCA.

Figure 6-5  Pro Tools Mix Window, Showing VCA Master Tracks Only

- Assign each object track to its corresponding dialogue, music, and effects reverb sends. Additionally, assign effects objects to the LFE send.
- Feed sends to auxiliary input tracks that are set up with processing plug-ins (such as reverbs).

13. Create object material from bed material by doing the following:
   - Copy bed material from a separate premix mono or stereo source, and paste it into mono or stereo object tracks.

14. Insert the Dolby Atmos Panner on each object track, and assign it an object number:
   - You can insert Panner plug-ins to the same insert position on all tracks, or all-selected tracks, using standard Pro Tools all (<Option>) or all-selected (<Option> + <Shift>) shortcuts. When you insert Panner plug-ins using Pro Tools all, or all selected shortcuts, you can choose how to autoassign numbers across new and existing plug-ins. For example, you can choose to not autoassign object numbers in the new plug-ins, or to autoassign new numbers across new and old plug-ins, or new plug-ins only. See Inserting Multiple Panner Plug-ins and Automatically Assigning Object Numbers.
   - Pro Tools sessions store Dolby Atmos metadata as plug-in automation until the mix is print mastered to the Dolby RMU. Alternatively, metadata can be fed directly to the RMU from another client (such as a System 5 configured with the System 5 Panner application).
   - You can use a joystick (such as the JL Cooper MCS-Panner) to control a Panner plug-in. When the joystick has been prepared, you can use it to grab the object
(pan location cursor) and position it anywhere in the Panner virtual room. See  
Preparing to Use the Joystick.

- You can use the Dolby Atmos Monitor stand-alone application for local or 
remote monitoring of the Dolby RMU as it renders material from Pro Tools. For 
example, from the Monitor, you can monitor the status of objects and their levels.

15. Assign object tracks to appropriate outputs. Make sure that the object ID number 
matches the output that the object track is routed to. For example, the track for object 
1 in Pro Tools should route to the path for object 1 in the RMU.

16. Create 9.1 reverbs in Pro Tools: Set up reverb groups for objects (for example, two for 
dialogue, two for effects, and one for music). The benefit of the reverb groups is that 
they allow for individual control over the wet signal fed to the zones by riding the 
reverb returns:
   a. Each reverb group should consist of four stereo tracks, each with a plug-in (such 
as ReVibe®) inserted on it.
   b. Each of the four tracks in the reverb group is fed from the same stereo send.
   c. Pan the four plug-in groups in the following manner:
      a. Reverb track 1: L/R
      b. Reverb track 2: Lss/Rss
      c. Reverb track 3 Lsr/Rsr
      d. Reverb track 4: Overhead surround L/R
d. Assign the reverb returns to their respective bed subbuses (dialogue, music, effects) so that they are combined with the dry signal when creating stems for further mixing.

Figure 6-6  Pro Tools Edit Window, Showing Dialogue Reverb Returns with VCA Master Tracks

17. Insert an LFE plug-in (such as Lowender, by reFuse) on an auxiliary input. Feed the input from a single send path, primarily from effects object tracks (because premixes have recorded LFE), and then return the signal directly to the LFE effects subbus.

18. Consider having access to a sound library, so that you can bring in new sounds, or extend existing effects and Foley moments in the Dolby Atmos mix.

19. Work with the Panner plug-in for each object: See Using the Panner Plug-in to Position Objects.

20. Create additional Pro Tools sessions for each movie reel, using the session setup, I/O routing, and track and plug-in layout from the Pro Tools template session. To keep the mixing console layout consistent and facilitate further mixing (such as stem creation, downmixes, and music and effects), try to keep the routing and object tracks consistent from reel to reel.

21. Record a Dolby Atmos Print Master. This includes recording the final 9.1 bed, up to 118 audio objects, and the associated Dolby Atmos metadata to an RMU.
6.2 Using Traditional Dolby 7.1 (or 5.1) Mix Audio Channels and Console Automation to Create a Dolby Atmos Mix

The following workflow provides one example of how a mix session can be set up to use a Dolby 7.1 mix and Avid® System 5 console automation to create a Dolby Atmos mix. With this setup, you can monitor the source audio and console automation while using System 5 channel strips to write Dolby Atmos metadata to a dedicated Pro Tools record machine. To finalize the Dolby Atmos mix, you record the source audio and console automation to the Pro Tools record machine. From this machine, you can combine mix reels and record a single print master to the Dolby RMU.

The workflow for using a 5.1 mix is the same:

1. Set up a Dolby Atmos mixing stage that mirrors the Dolby 7.1 mixing stage, and in addition includes a Dolby RMU. Alternatively, you can add a Dolby RMU to the 7.1 mix stage to turn it into a Dolby Atmos mix stage.

For more information on setting up a Dolby Atmos RMU hardware interface, see the manual for your Dolby Rendering and Mastering Unit.
In this workflow example, audio from multiple Pro Tools playback machines and automation from one or two System 5 mixing consoles feed a Pro Tools recorder machine that contains the final mix tracks.

**Figure 6-8** Dolby Atmos Mix Stage Block Diagram
2. **Transfer sessions and audio from the 7.1 playback machines to the Dolby Atmos playback machines.**

   Consider setting up dedicated playback machines and routing to dedicated System 5 consoles, based on the function of the audio and its automation. For example:
   - Route dialogue and music machines to the dialogue/music console.
   - Route the Fix, Effects Premixes, ambience Foley, and stem machines to the effects console.

3. **Load automation data from the 7.1 mix stage consoles to the Dolby Atmos mix stage consoles.**

   Install the System 5 Panner application to control Dolby Atmos metadata with System 5 console channel strips, as described in the *System 5 Panner Application for Dolby Atmos Manual*:
   - When using two consoles (as shown in this workflow), the application must be installed on two separate machines.
   - Identify available machines that can run the application. The destination machines should be machines that do not require EUCON™ control of audio by the console because System 5 Panner connection requires that EUCON mode is disabled in Pro Tools peripherals preferences page. In this workflow example, the System 5 Panner application is installed on two Pro Tools playback machines (fix and effects premix).
   - Install EUCON software on the two playback machines.

4. **On each System 5 console, reconfigure buses to route bed material to the Pro Tools record machine:**
   - 7.1 bed.
   - Stereo overhead surround. This stereo aux send should be configured to send material to the overhead surround arrays.
   - 7.1 alternative bus (optional): Internally reassign this bus to L, C, R, OhL, OhR, Lsr, Rsr, and LFE. This lets you pan from onscreen to overheads (instead of to Lss and Rss) and onward to back surrounds without having to use objects.

   **Note:** All sound elements are rebused to the bed at the start of the reel. An exception is the music stem L and R, which are assigned to object buses and panned in between the screen L/R and the first surrounds to create movement (widening) of music from screen to first surrounds. This frees up screen audio space for effects.

5. **On each System 5 console, reconfigure buses to route object material to object tracks on the Pro Tools record machine:**
   - Create objects audio by rebusing elements from the bed.
   - To preserve 7.1 L/C/R panning automation when routing to object tracks, configure buses as L/C/R buses.
6. Set up object bus level and panning.
   Individual buses cannot be automated on the System 5. As a workaround, route the object bus insert send to an input channel, and then route its postfader channel output returns to the object bus insert return. All fader and audio processing automation is written on the input channel. The input channel will be paired with the Dolby Atmos panner strip, side by side in the channel layout.

7. Consider adding an Artist Series controller for additional remote control of the Pro Tools record machine.
   The Artist Series controller can access AutoMatch and Preview modes, as well as all manual write commands.

8. Install the Dolby Atmos authoring tools on the Pro Tools record machine.
   The Pro Tools record machine for the Dolby Atmos mix stage monitors and records the bed and object audio, plus records Dolby Atmos metadata from the System 5 Panner and RMU. Dolby Atmos Panner plug-ins on panner tracks define active objects. The machine is a Pro Tools HDX system, with two cards and two external MADI I/Os.

9. **Configure basic routing in Pro Tools** (via Pro Tools I/O Setup). Create separate output paths for the bed and objects with the following considerations:
   - Beds include two output paths, one for the Dolby RMU 7.1 arrays, and the other for the RMU overhead surround arrays. Outputs 1–8 are set up as a single 7.1 output with mono subpaths. The multichannel path is named “Atmos 7.1 Bed.” In Pro Tools, the physical output order is L, R, C, LFE, Lss, Rss, Lsr, Rsr. These outputs address the RMU 7.1 arrays. Outputs 9–10 are set up as a single stereo output with mono subpaths, named “Atmos OH Bed.” These outputs address the RMU overhead surround arrays.

   **Note:** The track layout on the RMU is different (L, C, R, ... OhR). As an alternative to using I/O Setup to map Pro Tools film-based ordering of outputs to RMU inputs that use SMPTE/ITU-based ordering, you can create a cross patch in the MADI patch on the System 5 between the recorder machine and the RMU.

   - Outputs 11–118 are object outputs. They are set up as stereo outputs with mono subpaths, so that they can be used on stereo and mono object tracks. They address the RMU object inputs. Name the object I/O paths with their respective categories (typically “Dx,” “Mx,” and “Fx”) to reduce errors when assigning the I/O to the tracks.

10. **Create a new Pro Tools session** for the Dolby Atmos mix.

11. Configure session settings.
   a. Choose **Setup > Session**.
   b. Set the session start time to match the reel number. (For example, reel 2 is 2:00:00:00.) If you are planning on creating one print master from one session, set session start to match the first reel.
   c. In the **Format** section, set **Sample Rate** to 48 kHz.
   d. In the **Format** section, set the **Timecode Rate** to match the playback source session timecode rate. If the timecode rate is not 24 fps (which will be required when
print mastering), you need to configure the mix session for the different rate. Additionally, you must enable sample-rate conversion for the HD MADI interfaces.

In this example, the timecode for the source sessions is 29.97, so the playback machine requires the following settings for mixing:

a. Set clock source to its reference video reference.

b. In the **Format** section, set the **Timecode Rate** to 29.97.

c. In the **Timecode Settings** section, set **Audio Rate Pull Up/Down** to **0.1% Down**. This changes the sample rate to 47,952. In order to convert the incoming 48 kHZ signal, sample rate conversion must be engaged in the **Hardware Setup** dialog. The MADI I/O requires a separate 48 kHz word clock connection to the sample-rate converter MADI input.

d. Choose **Setup > Hardware**, and enable sample-rate conversion for the sample-rate converter MADI input. Repeat this step for the other MADI I/O.

---

**Note:** When print mastering a session that was mixed in a timecode rate other than 24 fps, the session settings will need to be reconfigured. See [Working with a Timecode Rate Other than 24 FPS](#).

---

12. Set up bed audio tracks on the Pro Tools recorder machine.

You will use the bed tracks to monitor and record bed audio created from mix audio channels and console automation:

a. Create ten tracks to represent the bed portion of the Dolby Atmos print master.

b. Name the tracks to match Dolby Atmos 9.1 layout order (L, C, R, Lss, Rss, Lsr, Rsr, LFE, OhL, and OhR). For example, name the first track "Bed.L," the second track "Bed.C," and so on.

c. Directly assign all inputs and outputs.

d. When all the tracks have been created and named, save the session.

13. Set up object audio tracks on the Pro Tools recorder machine:

You will use the object tracks to monitor and record object audio created from mix audio channels and console automation.

a. Create up to 118 object tracks after the bed tracks.

b. For better management, consider naming objects and dividing them up based on category: dialogue, music, and effects. For example, name the first object (on track 11) "Dx Object 1."

c. Directly assign all inputs and outputs.

d. When all the tracks have been created and named, save the session.
14. Set up panner tracks.

These tracks will be used to hold Panner plug-ins and record object panning positions and other Dolby Atmos metadata from the System 5. Create the same number of tracks that were created for object audio. Tracks should be named with a .1 extension (for example, "Dx Object 1.1") to facilitate ordering.

   a. Ensure all object audio tracks have been named and the session saved.
   b. Re-import the object audio tracks as new tracks via import session data. (This will automatically name the panner tracks with a .1 extension and will be of use when ordering the tracks described in the following steps.)

15. To simplify track handling, create groups with the following suggested names:
   - “Bed”: Group all bed audio tracks. Use this group to assign all bed tracks to a VCA master.
   - “All Objects”: Group all object audio tracks. Use this group to assign all object tracks to a VCA master.
   - “All Panners: Group all tracks with Panner plug-ins. Use this group to insert plug-ins and assign object numbers.
   - “Pec-Direct”: Group all bed and object audio tracks. Use to show bed and object audio tracks only, to put them into input or record (for monitoring or recording audio, respectively).
   - “Dx Objects”: Group all dialogue object tracks. Use to assign all dialogue objects to a VCA master.
   - “Mx Objects”: Group all music object tracks. Use to assign all music objects to a VCA master.
   - “Fx Objects”: Group all effects object tracks. Use to assign all effects objects to a VCA master.
   - “Rec Ready”: Group all bed and object audio tracks. Use to track arm (record and input controls) for bed and object audio tracks.
   - “Automation”: Group all tracks with object Panner plug-ins. Use to select an automation mode for all panner tracks.

16. For the VCA groups, create the following VCA masters and assign them to their respective group.
   - Bed
   - All Objects
   - Dx Objects
   - Mx Objects
   - Fx Objects
17. For the groups that will be used to record audio and write panner automation, create audio tracks and make them members of their respective groups, as follows:
   - Rec Ready
   - Automation

18. Insert Panner plug-ins on each panner track and assign an object number to each plug-in.
   a. On the Pro Tools mixing preferences page, click (enable) Plug-in Controls Default to Auto Enabled. This will eliminate the need to manually enable automation for each inserted Panner plug-in before recording Dolby Atmos metadata.
   b. Use the All Panners Group to select the panner tracks only.
   c. Insert Panner plug-ins to the same insert position on all selected tracks using the (<Option>+<Shift>) shortcut.
   d. When prompted, autoassign numbers to all of the new plug-ins. For more information, see Inserting Multiple Panner Plug-ins and Automatically Assigning Object Numbers.

19. Sort the tracks by name, so that each panner track now immediately follows its respective object audio track.

20. Map Panner plug-ins to System 5 channel strips.
    See the System 5 Panner Application for Dolby Atmos Manual.

21. Configure session automation:
   - In the automation window, enable automation for plug-ins only. Click (write enable) the plug-in button. Disable the other write enable controls.
   - Enable Write Automation to Next Breakpoint on Stop.
   - On the Pro Tools mixing preferences page, click (enable) Latching Behavior for Switch Controls in “Touch.” This will let you press a switch (such as Sphere mode) and have it latch during automation record pass (instead of having to hold it).
   - On the Pro Tools mixing preferences page, click (enable) Allow Latch Prime on Stop. This lets you prepare the step prior to the automation record pass. In the Options menu, check Link Track and Edit Selection. This is required if you using an optional Artist Series control surface.
   - Enable the Rec Ready and Automation groups. Ensure that none of the objects-based groups are enabled.

22. Configure the session audio tracks to monitor mix audio channels and automation:
   - Make sure the Rec Ready group is enabled.
   - In the Rec Ready track, set the fader to 0 to set all audio tracks to 0.
   - In the Rec Ready track, enable TrackInput to set all bed and object tracks to TrackInput mode so that the mix audio can be monitored.

23. Configure the panner track to record Dolby Atmos metadata from System 5 and any other clients.
   - Make sure the Automation group is enabled.
   - Set the automation mode for all panner tracks by setting the automation in the Automation track. For the first record pass, set the automation to Latch. For
subsequent passes, change to Touch, because it is not possible to match out from the System 5 controls.

24. Start the playback machines.

25. Begin recording Dolby Atmos metadata moves using the System 5 channel strips that were configured as panner strips.
   Panning information is recorded in automation playlists.

Note: If needed, adjust audio levels using System 5 channel strips that were configured to control audio channels.

26. For subsequent metadata recording passes, change automation to Touch.

27. When ready to record audio to the Pro Tools record machine, configure the session audio tracks:
   • Enable DestructivePunch record mode in the session.
   • Make sure the Rec Ready group is enabled.
   • In the Rec Ready track, set the fader to 0 to set all audio tracks to 0.
   • In the Rec Ready track, click the record enable button to enable the track for destructive punch recording. This will enable destructive punch recording for all bed and object tracks.

28. Start the playback machines and begin recording mix audio to the Pro Tools recorder machine.
   Audio is recorded in bed and object audio tracks.

29. When finished recording, consider combining object audio tracks and panner tracks to reduce the number of tracks.

30. For subsequent reels, create new sessions and repeat the previous steps.

31. Bring all the reels into one master session.

32. Join the reels together. Use crossfades as needed.

33. Record a Dolby Atmos Print Master.
Index

2
23.98 fps session • 20
24 fps session • 18

A
ATTEN control (in the Monitor) • 64
authoring tools
goinging started • 11
installer • 9
installing • 9
Monitor application • 4
optional tools • 5
Panner plug-in • 4
Autoassign options • 85
automating Panner controls • 102

B
bed material
working with • 17
bypass mode (in the Panner) • 91

C
celing elevation • 93
disabling • 94
using • 93
chase LTC button (in the Monitor) • 64
console control of Panner
Avid D-Cmmand • 89
Avid D-Control • 89, 90
Avid System 5 • 89
supported consoles • 89
Surround Panner option • 90
System 5 Panner application • 89

D
default operation mode (in the Panner) • 92
DIM button (in the Monitor) • 64
Dolby Atmos
hearing audio • 26
metadata flow • 2
mix overview • 1
specification for Pro Tools • 14
system overview • 2
workflows • 105

E
Elevation mode
disabling • 93
using • 92
Elevation Snap modes • 93
celing elevation • 93
sphere elevation • 94
using • 93
wedge elevation • 94

I
installing
Dolby Atmos tools • 9
joystick (for Panner control) • 86

J
joystick control of Panner
configuring in a Panner • 87
installing • 86
JLCooper MCS-Panner • 86
preparing for use • 86
Surround Panner option • 90
using • 86

K
keyboard shortcuts
for Monitor • 61
timecode right-click commands • 63

L
Linking selector (in the Panner) • 80
live mode monitoring • 40

M
metadata flow • 2
mix overview • 1
Mode section (in the Monitor) • 62
Monitor application
- before using • 30
- changing timecode location for playback • 44
- clearing clips • 60
- controls • 61
- displays • 61
- enabling communication with RMU • 31
- hearing Dolby Atmos audio • 26
- installing • 11
- keyboard shortcuts • 61
- launching • 30
- live mode monitoring • 40
- Mode section • 62
- Objects Only mode • 59
- objects view • 50
- operation modes • 40
- Outputs section • 64
- playing back a print master • 43
- print master • 41
- punching in and out of recording • 42
- Renderer section • 62
- RMU output meters • 53
- room configuration display • 58
- room configuration not loading • 37
- signal generator • 66
- Time section • 63
- timecode right-click commands • 63
- Transport section • 64
- using • 29
- verifying communication with RMU • 34
- verifying room configuration • 36
- View section • 65
- views • 46
- Waiting for Room Configuration message • 31
- window header • 62
- MUTE button (in the Monitor) • 64

O
- Object ID section • 84
- object number (in the Panner)
  - automatically assigning object numbers • 84
  - manually assigning an object number • 81
- object number box (in the Monitor) • 73
- objects
  - changing location • 75
  - monitoring • 48
  - objects view • 52
  - Size slider • 76
  - using • 86
  - using a console • 88
  - using a keyboard • 91
  - using a mouse • 91
  - working with • 18
- objects view • 50
- operation modes (in the Panner) • 91
  - bypass mode • 91
  - ceiling elevation • 93
  - default mode • 92
  - Elevation mode • 92
  - Elevation Snap modes • 93
  - list of operation modes • 91
  - Speaker Snap mode • 99
  - sphere elevation • 94
  - wedge elevation • 94
  - Zones • 99
- Outputs section (in the Monitor) • 64
  - ATTEN control • 64
  - DIM button • 64
  - MUTE button • 64

P
- Panner plug-in
  - authorizing • 10
  - Autoassign options • 85
  - automatically assigning object numbers • 84
  - considerations • 71
  - control surface • 88
  - general use • 71
  - inserting multiple plug-ins • 84
  - installing • 9
  - joystick • 86
  - list of ways to control • 85
  - manually assigning an object number • 81
  - mixing console • 88
  - operation modes • 91
  - Panner plug-in window • 71
  - recording metadata from the RMU • 95
  - using • 69
Panner plug-in window • 71
  automating Panner controls • 102
  configuration options button • 79
  configuring a joystick • 87
  elevation and z-coordinates • 76
  inserting in Pro Tools • 80
  Linking selector • 80
  list of buttons and zones selector • 74
  list of controls and displays • 71
  Object ID section • 84
  object number box • 73
  object size slider and level display • 76
  renderer connection status • 84
  resizing the window • 103
  stereo plug-in • 100
  virtual room • 72
  x, y, and z position displays • 75
  x, y, and z sliders • 75
pink noise
  generating to a speaker • 66
  generating to a speaker array • 67
play button (in the Monitor) • 64
playing back a print master • 43
print master
  playing back a print master • 43
  print master • 41
punching in and out of recording • 42
  timecode location for playback • 44
Pro Tools
  23.98 fps session • 20
  24 fps session • 18
  configuring I/O Setup • 21
  configuring tracks and signal routing • 24
  creating a new session • 18
  multiple Pro Tools systems • 27
  reconfiguring an existing session • 19
  session requirements • 16
punching in and out of recording • 42
R
record arm button (in the Monitor) • 64
Recorder mode • 95
recording
  metadata from the RMU • 95
  print master • 41
renderer connection status (in Panner plug-in) • 84
Renderer section (in the Monitor) • 62
rendering
  mode • 62
  Objects Only mode • 59
  to a surround format • 38
re-rendering
  bass management routing • 39
  clip level • 38
  re-render options • 38
  surround gain • 39
  to a surround format • 38
RMU
  enabling communication with Monitor • 31
  MADI inputs • 15
  RMU output meters • 53
RMU audio output
  clearing clips • 60
  dimming • 58
  gain changing • 59
  muting • 59
  Objects Only mode • 59
room configuration
  display • 58
  monitoring • 57
  verifying room configuration • 36
  Waiting for Room Configuration message • 31
S
shortcuts
  for Monitor • 61
  timecode right-click commands • 63
signal generator (in the Monitor) • 66
Size slider (in the Panner) • 76
Speaker Snap mode • 99
  disabling • 99
  using • 99
sphere elevation • 94
  disabling • 94
  using • 94
stereo Panner plug-in • 100
  Linking Panner plug-in options • 101
  using • 100
stop button (in the Monitor) • 64
System 5 Panner application • 89
system overview • 2
Index

T
Time section (in the Monitor) • 63
timecode right-click commands • 63
transport buttons (in the Monitor) • 64
Transport section (in the Monitor) • 64
troubleshooting
  Monitor communication with the RMU • 34
  room configuration not loading • 37

V
View section (in the Monitor) • 65
virtual room (in the Panner) • 72

W
wedge elevation • 94
  disabling • 95
  using • 94
  Zones (in the Panner) • 99